
 

1 

 

 

 

 

 

1. Selecting the Entire Document in MS Word 

 Shortcut Key: Use Ctrl + A. 

 Alternative Methods: 
o On the Home tab, in the Editing group, click Select > Select All. 

o Move the pointer to the left of any text until it turns into a right-pointing arrow, then triple-click. 

 

2. Programming Language for Applets 

 Language : Java. 
 Features of Java: 

o Concurrent, class-based, object-oriented. 
o "Write once, run anywhere" (WORA) capability.  
o Developed by James Gosling at Sun Microsystems in 1995.  

o Popular for client-server web applications. 

 

3. Cybernetics 

 Definition: The study of control and communication in animals and machines. 
 Origin: Defined by Norbert Wiener in 1948. 

 Modern Use: Refers to technology-based control systems. 

 

4. Traditional Mouse and Mouse Pad 

 Purpose of Mouse Pad: Provides friction for better movement.  
 Functions of a Mouse: 

o Move the cursor. 
o Select items with clicks. 

o Access menus using right-click. 

 

5. Toggle and Modifier Keys 

 Toggle Keys: 
o Caps Lock: Capitalizes all letters.  

o Num Lock: Enables number input from the keypad.  
o Scroll Lock: Scrolls through content.  
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 Modifier Keys: 

o Shift, Alt, Ctrl, Fn. 

 

6. Number Systems 

 Hexadecimal: Includes 0-9 and A-F. 
 Other Systems: 

o Decimal: 0-9. 
o Binary: 0, 1. 
o Octal: 0-7. 

 

7. Titan Supercomputer 

 Country: USA. 
 Details: Cray XK7 system used at Oak Ridge National Laboratory.  

 

8. Booting a Computer 

 Booting: Loading the operating system. 

 Types: 
o Cold Boot: Starting from an OFF position.  
o Warm Boot: Restarting without completely turning off.  

 

9. COBOL Programming Language 

 Full Form: Common Business-Oriented Language. 
 Use: Business, finance, and administrative systems.  
 Generation: Second-generation computers. 

 

10. Examples of Web Browsers 

 Firefox: Developed by Mozilla Foundation. 

 Chrome: Developed by Google. 

 

11. Gutter Margin 

 Definition: Additional margin for binding in page layouts.  
 Placement: Inside edge of pages in facing layouts. 
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12. ASCII Code 

 Full Form: American Standard Code for Information Interchange.  

 Purpose: Numerical representation of characters and actions.  

 

13. Microsoft Windows Versions 

 Non-Version: Windows NE. 
 Features: GUI, multitasking, virtual memory, and peripheral support.  

 

14. Input vs. Output Devices 

 Output Devices: Monitor, speakers, printer, projector.  

 Webcam: Example of an input device. 

 

15. Domain Names 

 .com: Commercial. 
 .gov: Government. 

 .org: Non-Profit Organization. 
 .int: International Treaties. 

 .mil: Military. 

 

16. Fork in Computing 

 Definition: A process creating a copy of itself.  
 Use: Process creation in Unix- like systems. 

 

17. Assembly Language 

 Definition: Low-level programming language for specific processors.  

 Conversion: Compiled to machine code using an assembler.  

 

18. DirectX APIs 

 Developer: Microsoft. 
 Purpose: Multimedia tasks, especially gaming and video.  

 Examples: Direct3D, DirectSound, DirectMusic.  

19. Mobile Commerce (m-Commerce) 
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 Definition: Delivery of e-commerce via wireless technology. 

 Examples: Mobile ticketing, vouchers, coupons. 

 

20. Home Button in Web Browsers 

 Purpose: Returns to a designated start page or personalized web page.  

 

21. Zipping of a file 

 Definition: Method of lossless data compression. 
 Key Points: 

o Archive format containing one or more compressed files.  

o File extensions: .zip or .ZIP. 

 

22. Central Computer or Program 

 Term: Server. 
 Key Points: 

o Provides functionality for other devices or programs (clients). 

o Follows a client-server model. 
o Examples of services: Data/resource sharing, computation.  

 

23. Non-Graphical Web Browser 

 Definition: Browsers supporting only text, not graphics.  

 Examples of Graphical Browsers: Internet Explorer, Firefox, Safari, Chrome. 
 Non-Graphical Example: Apache (HTTP server).  

 

24. XP 

 Stands for: Extreme Programming. 
 Key Points: 

o Agile software development methodology.  
o Frequent releases, short cycles.  
o Improves software quality and customer responsiveness.  

 

25. Data Descriptions in Databases 

 Term: Data Dictionary (Metadata Repository).  
 Key Points: 

o Centralized information repository about data.  
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o Defines name, data type, and length of each field.  

 

26. Programming Language for Applets 

 Language: Java. 
 Key Points: 

o Small programs for specific tasks. 
o Runs within a larger program or web page.  

 

27. Parent Company of Google 

 Term: Alphabet Inc. 
 Key Points: 

o Established in 2015. 
o Parent company for Google and other subsidiaries.  

 

28. Properties of Fiber Optic 

 Functionality: Works on light refraction at critical angles.  

 Key Points: 
o Core made of high-quality glass or plastic. 
o Two modes: Single-mode (single ray) and Multi-mode (multiple rays). 

o Speed and special connectors: SC, ST, MT-RJ. 

 

29. Hexadecimal Number System 

 Base: 16. 
 Characteristics: 

o Digits: 0-9; Letters: A (10) to F (15). 

o Positions represent powers of 16. 

 

30. Computer Viruses 

 Examples: WannaCry, Code Red, Melissa. 
 Definition: Malicious software loaded without user knowledge.  
 First Virus: Elk Cloner (1982). 

 

31. PROM 

 Full Form: Programmable Read-Only Memory. 
 Key Points: 
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o Permanent digital memory. 

o Data cannot be changed once programmed.  

 

32. System Software 

 Definition: Files and programs forming an operating system. 
 Examples: Assemblers, compilers, system utilities, drivers.  

 

33. Real-Time Operating System 

 Definition: Processes inputs with minimal delay.  
 Examples: VRTX, RT Linux, Lynx. 
 Applications: Medical imaging, air traffic control.  

 

34. Bits in IPv4 

 IPv4 Address Length: 32 bits. 
 IPv6 Address Length: 128 bits. 

 

35. Blu-ray Disc Capacity 

 Single Layer: 25 GB. 
 Dual Layer: 50 GB. 

 

36. Permanent Memory in Computers 

 Term: Read-Only Memory (ROM). 
 Key Points: 

o Non-volatile memory. 
o Stores firmware and low-level programs. 

 

37. Mini Computers 

 Definition: Smaller versions of large computers.  
 Key Points: 

o Features of large computers.  
o Moderate physical size. 
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38. Processing 

 Definition: Transforming input into output.  
 Key Points: 

o Involves executing program instructions.  
o Multiple processes may run concurrently.  

 

39. 'E' in EPROM 

 Stands for: Erasable. 
 Key Points: 

o Data erased using ultraviolet light.  
o Used for firmware storage. 

 

40. Non-Impact Printers 

 Examples: Laser Printers, Inkjet Printers.  
 Comparison with Impact Printers: 

o Non-Impact: No physical contact; page printing.  

o Impact: Physical contact; uses ribbon (e.g., Dot-Matrix Printer). 

 

41. Programming Language for Smart Contracts 

 Language: Solidity. 
 Key Points: 

o Designed for writing smart contracts on Ethereum.  
o Open-source, governed by Ethereum Foundation.  
o Statically-typed language for Ethereum Virtual Machine (EVM).  

 

42. API 

 Definition: Application Programming Interface.  
 Key Points: 

o Set of rules enabling software communication.  
o Facilitates integration of different software systems. 

 

43. Non-Relational Database 

 Term: NoSQL Databases. 
 Examples: MongoDB, Cassandra, Redis, Neo4j.  
 Categories: Key-value stores, Graph stores, Column stores, Document stores.  
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44. Ctrl+F4 in MS Word 

 Function: Closes the current document.  
 Additional Shortcut: Alt+F4 closes all open documents and exits Word.  

 

45. JPEG 

 Full Form: Joint Photographic Experts Group. 
 Key Points: 

o Lossy compression format for digital images.  
o File Extensions: .jpg, .jpeg, .jpe, .jif, .jfif, .jfi. 

o Supports up to 24-bit color. 

 

46. Primary Key in Databases 

 Purpose: 
o Uniquely identifies records. 
o Ensures data integrity and prevents duplicates.  
o Establishes relationships between tables.  

 

47. DDoS 

 Full Form: Distributed Denial of Service. 
 Key Points: 

o Cyberattack using multiple compromised systems.  
o Floods target system with traffic to disrupt services.  

 

48. Excel Workbook Extensions 

 Excel 97-2003 Workbook: .xls. 
 Excel 2010/2007 Workbook: .xlsx. 
 Excel 2010/2007 Template: .xltx. 

 Excel 97-2003 Te mplate: .xlt. 

 

49. Northbridge 

 Function: Integrated circuit for CPU, memory, and AGP communication.  
 Key Points: 

o Directly connects components like RAM and graphics controller.  
o Acts as a bridge to the southbridge chip.  
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50. Google Social Networking Site 

 Term: Orkut. 
 Key Points: Closed in September 2014. 

 

51. Direct X 

 Developed By: Microsoft. 
 Key Points: 

o Collection of APIs for multimedia tasks.  
o Used in game programming and video rendering.  

 

52. macOS Versions 

 Examples: 
o Catalina (2019). 

o Mojave (2018). 
o High Sierra (2017). 

 

53. ISCII 

 Full Form: Indian Script Code for Information Interchange.  
 Developed By: Bureau of Indian Standards (1986).  
 Purpose: Coding scheme for Indian scripts and symbols.  

 

54. Virtual Memory 

 Definition: Temporary volatile memory on storage drive. 
 Key Points: 

o Created when RAM is low. 

o Slower than main memory. 

 

55. Apple Word Processor 

 Name: Pages. 

 Key Points: 
o Part of the iWork suite. 
o Runs on macOS, iPadOS, and iOS. 
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56. Social Media for B2B 

 Examples: 
o LinkedIn (ideal for networking).  

o Twitter (relevant conversations).  

 

57. Shortcut Keys in PowerPoint 

 New Slide: Ctrl+M. 

 Other Shortcuts: 
o Ctrl+N: New presentation. 
o Ctrl+B: Bold text. 

o Ctrl+K: Insert hyperlink. 

 

58. Frames Per Second (FPS) 

 Standard Rate: 30 fps. 

 Key Points: 
o Ensures smooth movement. 
o Industry standard for television. 

 

59. Example of Operating System 

 Examples: 
o Windows. 
o macOS. 

o Linux. 
 Definition: Manages hardware and software resources.  

 

60. Sequential File Access 

 Definition: Accessing data in a predetermined order.  
 Example: Tape storage. 

 

61. Footnote in MS Word 

 Location: Found under the Insert tab. 
 Steps: 

o Click where the footnote is needed. 

o Select Insert > Insert Footnote . 
o Word adds a reference mark in the text and footnote mark at the page's bottom.  
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62. Language for Creating Web Pages 

 Language: HTML (HyperText Markup Language).  
 Key Points: 

o Used to create web pages displayed on the Internet.  

o Identified by Uniform Resource Locator (URL).  

 

63. Word Size in Microprocessors 

 Definition: Maximum number of bits a microprocessor processes at a time.  
 Minimum Word Size: 16 bits. 

 Current Range: 16 to 64 bits. 
 Microprocessor Generations: 

o 1st Gen (1971-73): 4/8 bits. 
o 2nd Gen (1974-78): 8 bits. 
o 3rd Gen (1979-80): 16 bits. 

o 4th Gen (1981-95): 32 bits. 
o 5th Gen (1995–Present): 64 bits. 

 

64. Deep Blue Supercomputer 

 Developer: IBM. 
 Key Points: First computer to defeat a world chess champion under standard time controls.  

 

65. Dumb Terminal 

 Definition: A simple monitor with minimal processing power.  
 Key Points: Cannot process advanced functions like screen clearing or cursor control.  

 

66. Invalid Chart Type in Excel 

 Correct Chart Types: Line, Pie, Scatter, Bar. 

 Invalid Chart Type: Cube Chart. 

 

67. A-Z Sorting in MS Word 

 Function: Sorts text alphabetically in ascending order.  
 Steps: 

o Highlight the column to alphabetize.  
o Select Sort and Filter > Sort A to Z. 
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68. Transition Effects in PowerPoint 

 Definition: Motion and visual effects between slides.  
 Key Points: Used to create smooth transitions for better presentation flow. 

 

69. Nibble in Computing 

 Definition: A group of 4 bits. 
 Key Points: 

o Half of an Octet. 
o Represented by a single hexadecimal digit.  

 

70. Joystick 

 Definition: Input device for controlling positions and speed in video games.  
 Key Points: 

o Provides two-dimensional and three-dimensional control. 
o Used in games, flight simulators, etc.  

 

71. Logic Gates 

 Definition: Basic building blocks of digital systems. 
 Examples: AND, OR, NOT gates. 

 

72. Social Engineering Tactic 

 Example: Phishing. 

 Key Points: 
o Tricks individuals into providing sensitive data.  
o Common features: Hyperlinks, urgency, unusual senders.  

 

73. VGA Device 

 Full Form: Video Graphics Adapter/Array. 
 Key Points: 

o Display standard by IBM. 
o Provides 640x480 resolution with 16 colors at 60 Hz.  
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74. Projector 

 Definition: Device for displaying content on large screens.  
 Key Points: Commonly used for presentations and videos.  

 

75. Shortcut to Close Current Tab in Browsers 

 Shortcut: Ctrl + W (or Ctrl + Shift + W). 

 

76. WiMax Technology 

 Full Form: Worldwide Interoperability for Microwave Access.  

 Key Points: 
o Based on IEEE 802.16. 
o Range: Up to 50 km. 

o Speed: Up to 70 Mbps. 

 

77. W3C (World Wide Web Consortium) 

 Founder: Tim Berners-Lee. 
 Key Points: 

o Develops web standards. 
o Mission: Lead the web to its full potential.  

 

78. Thin-Film Transistor (TFT) 

 Variant of: Liquid Crystal Display (LCD). 
 Key Points: 

o Active matrix display technology. 

o Faster response and better display quality. 

 

79. Composite Key in Databases 

 Definition: Combination of two or more columns to uniquely identify table rows.  
 Key Point: Columns individually do not guarantee uniqueness.  

 

80. Firefox Web Browser 

 Developer: Mozilla Foundation. 
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 Key Features: 

o Tabbed browsing, spell check, pop-up blocker, private browsing. 
o Open-source and customizable with extensions.  

 

81. Language for Operating Systems 

 Most Appropriate Language: Assembly Level Language. 
 Key Points: 

o Directly runs on the processor.  

o Easier for programmers compared to machine language.  
o Used for operating systems and desktop applications.  

 

82. Title Bar 

 Definition: Horizontal bar at the top of a window. 
 Function: Displays the title of the software or current document.  

 

83. Embedded Program in GIF Images 

 Term: Web Bug or Web Beacon. 
 Key Points: 

o Tracks user behavior. 
o Cannot be accepted or rejected by users.  

 

84. Parasitic Virus 

 Definition: A virus that attaches itself to other programs.  
 Key Points: 

o Runs with the infected program. 

o Can make changes, install itself in memory, or replicate.  

 

85. HTTP 

 Full Form: HyperText Transfer Protocol.  
 Purpose: Used for retrieving HTML and other documents on the Internet.  

 

86. Error Messages in Web Browsers 

 404 Error: Resource not found (e.g., broken link, mistyped URL). 
 Other Errors: 
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o 400: Bad request. 

o 401: Unauthorized access. 
o 403: Forbidden access. 

 

87. Fourth Generation Computers 

 Examples: PUP 11, IBM 4341, DEC 10. 
 Key Points: 

o Period: 1971–1980. 

o Used Very Large Scale Integrated (VLSI) circuits.  
o Compact, reliable, and affordable.  

 

88. ROM 

 Full Form: Read-Only Memory. 
 Key Points: 

o Non-volatile memory (cannot write).  
o Stores instructions for starting a computer (bootstrap).  

 

89. Disadvantages of Batch Operating System 

 Key Points: 
o Lack of interaction between user and job. 

o Slow processing speed. 
o CPU idle during job preparation. 

 

90. VPN 

 Full Form: Virtual Private Network. 
 Purpose: Provides secure, private connections over public networks.  

 

91. Patch 

 Definition: Software update that modifies code in an executable program.  
 Purpose: Temporary fixes between full software releases.  

 

92. Tab Movement in MS Excel 

 Command: Press Tab key to move one column to the right.  
 Other Commands: 
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o Shift + Tab: Move one column left.  

o Ctrl + Home: Go to the first cell.  
o Ctrl + End: Go to the last cell.  

 

93. Data Storage Device 

 Term: Hard Disk Drive (HDD). 
 Key Points: 

o Non-volatile memory. 

o Data is accessed randomly (not sequentially).  

 

94. Network Interface Card (NIC) 

 Definition: Hardware component for network connection.  
 Function: Provides a dedicated connection to a LAN or network.  

 

95. PNG 

 Full Form: Portable Network Graphics. 
 Key Points: 

o Introduced in 1996. 

o Lossless compression. 
o Replaced GIF. 

 

96. MS Word Field Insertion 

 Shortcut Key: Ctrl + F9. 
 Function: Inserts a blank field containing curly brackets.  

 

97. Components of Data Transmission 

 Not a Component: Cube Chart. 
 Components: 

o Data, Sender, Receiver, Transmission Medium, Protocol.  

 

98. Communication in Motherboards 

 Term: Bus. 
 Definition: Set of parallel electrical conducting lines linking components.  
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99. Enterprise Application Software 

 Definition: Software designed to address an organization's needs.  
 Key Points: Supports mission-critical solutions in distributed environments. 

 

100. 'Windows Key + V' 

 Function: Opens the Clipboard bin. 
 Other Shortcuts: 

o Windows Key + L: Locks the device.  
o Windows Key + D: Displays/hides the desktop.  

o Windows Key + E: Opens File Explorer.  

 

101. Communication Between Computers 

 Term: Communication Protocols. 
 Key Points: 

o Formal descriptions of message formats and rules for telecommunications.  
o Cover authentication, error detection, correction, and signaling.  

o Essential for digital and analog communications in computer networks.  
o Implemented in hardware and software. 

 

102. Alternate Text for Images 

 HTML Attribute: <alt>. 
 Function: Provides text when an image cannot be displayed (e.g., due to slow connection, errors).  
 Use Case: Screen readers for accessibility.  

 

103. Screen Resolution 

 Definition: Number of horizontal and vertical pixels on a screen.  
 Key Points: 

o Higher resolution = more visible information without scrolling.  
o Determines the clarity and sharpness of the display.  

 

104. Quick Save in MS Word 

 Shortcut Key: Ctrl + S. 
 Purpose: Saves the document instantly to prevent data loss.  
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105. Domain Name 

 Definition: A human-readable address to access websites on the Internet.  
 Key Points: 

o Easier alternative to IP addresses.  

o Comprises letters, numbers, and extensions like .com, .org, .net. 

 

106. Malicious Program 

 Correct Option: C. Trojan Horse. 
 Definition: A malicious program disguised as legitimate software.  

 Other Types: 
o Worm: Self- replicating malware. 

o Spyware: Collects user information.  
o Keylogger: Records keystrokes.  

 

107. SmartArt Feature 

 Introduced In: MS Office 2007. 
 Purpose: Creates professional diagrams, including organization charts and flowcharts.  

 

108. Accessing Email Anywhere 

 Tool: Webmail Interface. 
 Examples: Gmail, Yahoo Mail, AOL Mail, Outlook.com. 
 Definition: Web-based email accessible via browsers.  

 

109. IMAP 

 Full Form: Internet Message Access Protocol.  
 Purpose: Access emails on remote servers.  
 Key Points: 

o Allows synchronization between devices.  
o Default port: 143. 

 

110. Linux and Unix 

 Type: Multitasking Operating Systems. 
 Purpose: Execute multiple tasks simultaneously.  
 Examples: Linux, Unix. 
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111. Active Slide in PowerPoint 

 Displayed In: Slide Area. 
 Additional Pane: Slide Thumbnails (to view multiple slides).  

 

112. Read Mode in MS Word 

 Function: Adjusts document layout to fit screen size for easier reading.  
 Key Points: Optimizes text, images, tables, and videos for readability.  

 

113. FORTRAN 

 Full Form: Formula Translation. 
 Purpose: Used for scientific, numerical, and engineering computations.  

 Applications: Bridge design, factory automation, weather analysis.  

 

114. Shortcut Keys in MS Word 

 Key Combinations: 
o Ctrl + C: Copy. 
o Ctrl + V: Paste. 
o Ctrl + X: Cut. 

o Ctrl + L: Left Alignment. 

 

115. MS Office View Tab 

 Groups: 

o Views: Print Layout, Web Layout, Outline.  
o Show: Ruler, Gridlines, Navigation Pane. 
o Zoom: Adjust document view size (10%–500%). 

 

116. Non-Object-Oriented Programming Languages 

 Examples: 
o Object-Oriented: Java, Python, MATLAB. 

o Non-Object-Oriented: FORTRAN, Assembly Language, C (not fully OOP). 
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117. Computer Generations 

 Examples: 
o 1st Gen: EDSAC, UNIVAC. 

o 2nd Gen: IBM-1620, CDC-1604. 
o 3rd Gen: IBM-360 series. 

o 4th Gen: IBM 4341, PUP 11. 
o 5th Gen: Robots, AI-based systems. 

 

118. BMP 

 Full Form: BitMaP. 
 Definition: Raster graphics format storing digital images.  
 Key Point: Uses spatially mapped bits to define image pixels.  

 

119. Types of ROM 

 Examples: 
o PROM: Programmable once. 
o EPROM: Erasable using UV light.  

o EEPROM: Erased and programmed electrically.  

 

120. Computer Versatility 

 Definition: Capability to perform multiple tasks simultaneously.  
 Key Characteristics: 

o Speed: Millions of calculations per second.  
o Accuracy: Minimal errors. 

o Diligence: Consistent performance without fatigue.  
o Versatility: Handles various operations concurrently. 
o Storage: Retains vast amounts of data for easy retrieval.  

 

121. Flash Memory 

 Devices Without Flash Memory: Car Radio. 
 Reason: Traditional car radios function to receive and play AM/FM signals and do not require data 

storage. 

 

122. UNIVAC 

 Full Form: Universal Automatic Computer.  
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 Key Points: 

o First general-purpose electronic digital computer for business applications.  
o Developed by Eckert-Mauchly Computer Corporation. 

 

123. PHP 

 Full Form: Hypertext Pre-Processor. 
 Key Points: 

o General-purpose scripting language suited for web development.  

o Used for managing dynamic content, databases, and session tracking.  

 

124. Storage Without Mechanical Components 

 Device: Solid-State Drive (SSD).  
 Key Points: 

o Uses integrated circuits for storage.  
o Advantages: Resistant to shock, silent, lower latency, faster access time.  

 

125. Font Properties in MS Word 

 Menu: Format Menu. 
 Subitem: Font. 
 Function: Allows changes to size, color, style, etc., of the text.  

 

126. Minimize Workbook in MS Excel  

 Shortcut Key: Ctrl + F9. 
 Other Shortcuts: 

o Ctrl + F5: Maximize window. 

o Ctrl + F4: Close workbook. 

 

127. Device for Hard Copies of Large Designs 

 Device: Plotter. 
 Use Case: Construction drawings, architectural plans, and business charts.  
 Types: Drum Plotters and Flatbed Plotters.  

 

128. Merging Cells in MS Excel 

 Feature: Merge Cells. 
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 Function: Combines two or more cells into one unified cell.  

 

129. Smallest High-Speed Storage in CPU 

 Storage: Register. 
 Function: Directly accessible memory locations for quick data processing. 

 

130. Memory Erased by UV Light 

 Type: EPROM (Erasable Programmable Read-Only Memory). 
 Key Points: 

o Erased using ultraviolet light.  
o Used in earlier BIOS chips. 

 

131. Permanent Deletion of Files 

 Feature: Recycle Bin. 
 Key Point: Files are not permanently deleted until removed from the Recycle Bin.  

 

132. Debugging Utility 

 Software Utility: Debugger. 
 Other Tools: 

o Linker: Combines object modules into executable programs.  

o Loader: Loads program objects into memory. 

 

133. Gmail Labels 

 Maximum Labels: 500 (including sub-labels). 
 Key Points: 

o Used for organizing emails.  
o Deleting labels does not delete the associated messages.  

 

134. Shapes Key in MS PowerPoint 

 Location: Drawing Group in Home Tab.  
 Other Groups in Home Tab: 

o Clipboard, Slides, Font, Paragraph, Editing.  
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135. DSL 

 Full Form: Digital Subscriber Line. 
 Key Points: 

o Transfers internet over copper telecommunication lines.  
o High-speed internet connectivity. 

 

136. Network Device with CAM Table 

 Device: Switch. 
 Key Points: 

o Maintains a Content Addressable Memory (CAM) table. 

o Has its own system configuration. 

 

137. Web Design 

 Definition: Planning, conceptualizing, and arranging online content.  

 Key Components: 
o Appearance: Colors, fonts, images.  
o Layout: Information structure and categorization. 

 

138. Excel Chart Types 

 Available Charts: Bar, Column, Line, Pie, Scatter, Stock.  
 Unavailable Chart: Cube Chart. 

 

139. High Data Rate Connection 

 Term: Broadband. 
 Key Points: 

o Uses wide bandwidth for data transmission.  

o Examples: Cable Internet, ADSL, Fiber Optics.  

 

140. Assembly Language 

 Definition: Low-level programming language. 
 Key Points: 

o Closely tied to machine code instructions.  
o Specific to a particular computer architecture.  
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141. IP Address Classes 

 Class C IP Address: 192 to 223 with default mask 255.255.255.0. 
 Other Classes: 

o Class A: 0 to 127, Mask: 255.0.0.0. 
o Class B: 128 to 191, Mask: 255.255.0.0. 

o Class D: 224 to 247 (Not used). 
o Class E: 248 to 255 (Not used). 

 

142. Default Tab in Microsoft Office 

 Tab: Home Tab. 
 Control Groups: 

o Clipboard: Copy, Paste, Cut, Format Painter.  

o Font: Style, Color, Size, Bold, Underline.  
o Paragraph: Bullets, Numbering, Alignment, Borders.  
o Styles: Listed Styles. 

o Editing: Find, Replace. 

 

143. First Calculating Device 

 Device: Pascaline. 

 Inventor: Blaise Pascal. 
 Features: Added and subtracted whole numbers using interlocked cogwheels.  

 

144. VPN 

 Full Form: Virtual Private Network.  
 Function: Scrambles data sent over the Internet by creating encrypted tunnels for secure communicat ion. 

 

145. First-Generation Computers 

 Electronic Component: Vacuum Tubes. 
 Examples: EDSAC, EDVAC, UNIVAC, IBM-701, IBM-650. 

 

146. Open-Source Operating Systems 

 Examples: 
o Linux Kernel, Linux Mint, Fedora, Chrome OS, React OS.  

 Key Feature: Freely available source code for modifications and distribution.  
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147. ISDN 

 Full Form: Integrated Services Digital Network.  
 Function: Simultaneous digital transmission of voice, video, and data over telephone lines.  

 

148. First Successful Email Virus 

 Virus: ILOVEYOU. 
 Spread: Via email attachments with enticing subject lines like "Love Letter for You." 
 Year: 2000. 

 

149. End Slideshow in PowerPoint 

 Shortcut Key: Esc (Escape). 
 Other Keys: 

o Tab: Select next object. 

o End: Go to end of slide. 
o Home: Go to beginning of slide. 

 

150. Close Active Window 

 Shortcut Key: Ctrl + W. 
 Other Commands: 

o Ctrl + F: Select search box. 

o Ctrl + Shift + N: Create new folder.  
o Ctrl + N: Open new window. 

 

151. Open Find and Replace in MS Word 

 Shortcut Key: Ctrl + G. 
 Other Keys: 

o Ctrl + F: Open Find Box. 

o Ctrl + K: Insert hyperlink. 
o Ctrl + M: Indent text. 

 

152. Check Object Properties 

 Shortcut Key: Alt + Enter. 
 Other Commands: 

o Alt + Spacebar: Opens active window menu.  
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153. Application Software 

 Definition: Software designed for specific user tasks like word processing, email communication, and 
gaming. 

 Examples: MS Word, Excel, Gmail. 

 

154. Windows 7 

 Launch Year: 2009. 
 Predecessor: Windows Vista (2006). 

 

155. Hybrid Computers 

 Definition: Combines features of analog and digital computers.  
 Function: Digital for logical operations, Analog for solving complex equations.  

 

156. Adware 

 Definition: Freeware requiring users to view advertisements for usage.  
 Purpose: Revenue generation for developers.  

 

157. Data 

 Definition: Unprocessed collection of raw facts suitable for communication, interpretation, and processing.  

 

158. Interpreter 

 Function: Executes programs step by step and identifies errors line by line.  
 Difference: Unlike a compiler, it does not generate machine code in advance. 

 

159. ISDN 

 Full Form: Integrated Services Digital Network.  

 Function: Allows transmission of data, voice, and video over digital telephone lines.  
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160. DuckDuckGo 

 Definition: A privacy-focused search engine. 
 Features: 

o Avoids user profiling. 
o Shows identical results for the same query to all users.  

 Founder: Gabriel Weinberg. 

 

161. Secondary Memory 

 Definition: Memory not directly accessible by the CPU, used for long-term storage. 
 Examples: 

o Hard Disk Drives (HDDs): Magnetic storage with large capacity.  
o Solid-State Drives (SSDs): Flash memory, faster than HDDs. 

o Optical Discs: CDs, DVDs, Blu-ray discs. 
o USB Flash Drives: Portable and connect via USB. 
o External Hard Drives: HDDs or SSDs in an external enclosure.  

o Memory Cards: SD, microSD, CompactFlash cards.  
o Magnetic Tapes: For backup and archival purposes. 

o Network Attached Storage (NAS): File storage over a network. 
o Cloud Storage: Online storage services (e.g., Google Drive, Dropbox).  

 

162. IoT 

 Full Form: Internet of Things. 
 Definition: Network of interconnected physical devices embedded with sensors and software to exchange 

data. 

 

163. First Printer for Engineering Drawings 

 Device: Plotters. 
 Key Points: 

o Can print full-size engineering drawings. 

o Frequently used in CAD and CAM applications. 

 

164. Primary Key in Databases 

 Purpose: 
o Uniqueness: Ensures each record is uniquely identifiable.  

o Data Integrity: Prevents duplicate records. 
o Relationships: Links tables using foreign keys. 
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165. Alignment Group in MS Excel 

 Buttons in Alignment Group: 
o Top, Middle, Bottom Alignment.  

o Left, Right, Center Alignment.  
o Orientation, Wrap Text, Merge & Center.  

o Indent Decrease & Increase. 
 Not Included: Comma Style (part of Number Group).  

 

166. Correct Abbreviations 

 Correct Pairs: 
o GPRS: General Packet Radio Service. 
o MICR: Magnetic Ink Character Recognition.  

o PNG: Portable Network Graphics. 
o SIM: Subscriber Identity Module. 

 

167. SDRAM 

 Full Form: Synchronous Dynamic Random Access Memory.  
 Feature: Synchronizes with the system clock for higher speeds. 

 

168. Memory Units 

 Hierarchy: 
o 1 Zettabyte (ZB): 1024 Exabytes (EB). 

o 1 Yottabyte (YB): 1024 Zettabytes (ZB). 

 

169. High-Speed Broadband Transmission 

 Included Technologies: 
o DSL, Cable Modem, Fiber, Satellite, Wireless, BPL. 

 Not Included: Traditional Dial-Up. 

 

170. Excel Formulas 

 Formula Syntax: Begins with "=". 
 Example: =SUM(A1:A5). 
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171. Functions of MS Word 

 Functions: 
o Composition, Editing, Formatting, Printing.  

 Not a Function: Complex data processing (handled by Excel).  

 

172. MBR 

 Full Form: Master Boot Record.  

 Location: Beginning of the hard drive, contains partition table.  

 

173. Microsoft Email Program 

 Program: Outlook. 
 Key Features: Email, calendar management, contact storage, task tracking.  

 

174. Open Task Manager 

 Shortcut Key: Ctrl + Shift + ESC.  
 Function: Monitor processes, applications, and system status.  

 

175. MICR 

 Full Form: Magnetic Ink Character Recognition.  
 Purpose: Processes cheques quickly using machine-readable codes. 

 

176. Glitch 

 Definition: Small, fleeting error in a system due to unknown causes.  
 Impact: Can cause power failure, data loss, or service interruption.  

 

177. PowerPoint Shortcuts 

 Close PowerPoint: Ctrl + Q. 
 Start Slideshow: F5. 

 Insert Tab: Alt + N. 
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178. Utility Software 

 Examples: 
o Antivirus Software. 

o Backup Software, Disk Tools.  
 Function: Manage and maintain computer resources.  

 

179. Semiconductor Memory 

 Definition: Memory made of semiconducting materials.  
 Examples: RAM, ROM. 

 

180. Compiler 

 Definition: Converts high- level language into machine code. 
 Function: Reports all errors with line numbers.  
 Interpreter: Converts and executes line by line.  

 

 

181. Wireless Personal Area Network (WPAN) 

 Definition: Uses wireless communication to transfer data between connected devices.  
 Devices: PDAs, smartphones, tablet PCs. 

 Feature: Known as a short wireless distance network.  

 

182. Shortcut Creation in MS Excel 

 Function: HYPERLINK.  
 Description: Creates a shortcut to open documents stored on a network server, intranet, or the Internet.  

 

183. Java Programming Language 

 Creators: James Gosling and Mike Sheridan.  
 Company: Sun Microsystems. 

 Year: 1990s. 
 Key Feature: "Write Once, Run Anywhere" (WORA) principle.  
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184. Object-Oriented Databases 

 Definition: Stores data in the form of objects containing data and methods.  
 Languages Supported: Delphi, Ruby, C++, Java, Python. 

 Examples: TORNADO, Gemstone, ObjectStore, GBase, InterSystems Cache.  

 

185. Saving a Document in MS Word 

 Ways to Save: 

1. File > Save. 
2. Ctrl + S. 
3. Save button. 

 

186. Dynamic Host Configuration Protocol (DHCP) 

 Definition: Client/server protocol for automatic assignment of IP addresses.  
 Additional Configurations: Subnet mask, default gateway. 

 

187. Foreign Key in Databases 

 Definition: Acts as a reference between tables by pointing to a primary key in another table.  
 Key Points: 

o Allows null and duplicate values.  

o Identifies relationships between tables.  

 

188. Word in Computing 

 Definition: Fixed-sized piece of data handled by a processor. 
 Key Points: 

o Word Size: 8 bits to 96 bits. 
o Nibble: 4 bits. 

o Bit: 0 or 1. 
o Crumb: Two binary digits (rarely used).  

 

189. Default Location for Installed Programs 

 Directory: C:\Program Files or C:\Program Files (x86). 
 Purpose: Stores 64-bit and 32-bit applications respectively. 

 



 

32 

 

190. Shift Key 

 Function: Capitalizes letters and enters symbols.  
 Other Keys: 

o Ctrl: For shortcuts (e.g., Ctrl + S).  
o Alt: Used with numeric keys for shortcuts.  

o Fn: Controls brightness and volume. 

 

191. Expansion Bay 

 Definition: Open section in a computer for add-ons (e.g., hard drives, CD-ROM drives). 
 Sizes: 3.5-inch and 5.25- inch. 

 

192. RAID Technology 

 Full Form: Redundant Array of Independent Disks. 
 Types: 

o RAID 0: Striping (no redundancy). 
o RAID 1: Mirroring (redundancy). 
o RAID 5: Striping with parity (balance of performance and redundancy).  

o RAID 6: Double parity (high redundancy).  
o RAID 10: Combination of RAID 1 and RAID 0. 

 

193. Print Preview in MS Word 

 Shortcut Key: Ctrl + F2. 

 

194. Caps Lock 

 Function: Enables typing in uppercase without using the Shift key.  

 

195. System Software 

 Definition: Software that manages hardware and provides a platform for application software.  
 Examples: Operating system, database manager, interpreter.  

 

196. Apple Web Browser 

 Browser: Safari. 
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 Function: Accesses and renders HTML for websites.  

 

197. Web Hosting 

 Definition: Service that allows organizations to make websites accessible via the WWW. 

 

198. Resource Identification on the Web 

 Identifier: URL (Uniform Resource Locator).  

 

199. Private Network Communication Protocol 

 Protocol: TCP/IP (Transmission Control Protocol/Internet Protocol).  
 Function: Enables communication in private networks and on the Internet.  

 

200. Shortcut Keys in MS Word 

 Keys: 
o Ctrl + Del: Deletes word to the right of the cursor.  

o Ctrl + Backspace: Deletes word to the left of the cursor.  
o Ctrl + End: Moves cursor to the document's end. 

o Ctrl + Home: Moves cursor to the document's beginning.  
o Ctrl + Spacebar: Resets text to default font. 

 

201. Parallel Port 

 Definition: Sends or receives 8 bits (1 byte) at a time in parallel. 
 Connector: 25-pin female connector. 
 Uses: Connects printers, scanners, and external hard drives.  

 

202. Minicomputer 

 Definition: Smaller in physical size but retains features of large computers.  
 Uses: Small to mid-range servers for business and scientific applications.  
 Alternate Name: Mid-range computer. 

 

http://www/
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203. First Intel Microprocessor 

 Processor: Intel 4004. 
 Year: 1971. 

 Feature: First commercially available microprocessor.  

 

204. Kernel 

 Definition: Core program of an operating system. 

 Function: Manages memory, CPU operations, and hardware interaction.  

 

205. Impact Printers 

 Examples: Dot Matrix, Daisy-Wheel, Ball Printers.  
 Definition: Use mechanical impact to transfer ink to paper.  

 Modern Use: Rare, replaced by non- impact printers. 

 

206. Router 

 Function: Manages traffic by forwarding data packets to their IP addresses.  
 Secondary Use: Allows multiple devices to share an internet connection. 

 

207. IMAP 

 Full Form: Internet Message Access Protocol.  
 Function: Access emails on a remote server.  

 Port: 143. 

 

208. Deleted Emails Location 

 Folder: Trash. 
 Retention: Typically retained for up to 30 days for recovery.  

 

209. Protocols in Application Layer 

 Layer: Application Layer of TCP/IP.  
 Protocols: HTTP, TELNET, FTP, SMTP, DNS. 
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210. Characteristics of ROM 

 Full Form: Read Only Memory.  
 Key Features: 

o Non-volatile, retains data permanently.  
o Used for storing software instructions.  

o Semiconductor memory type. 

 

211. Blue Wavy Lines in MS Word 

 Indication: Format Consistency Checker detects inconsistencies in text formatting.  

 

212. OLE in MS Access 

 Full Form: Object Linking & Embedding.  
 Use: Stores audio, video, and binary large objects (up to 2GB).  

 

213. Distributed Operating System 

 Definition: Allows multiple users on different terminals to access a single OS. 
 Advantages: 

o Reduces load on the host. 
o Improves operational efficiency.  

 

214. Cell Identification in Excel 

 Definition: Identified by Column Letter + Row Number.  
 Example: Cell in Column "C" and Row "3" is C3. 

 

215. Characteristics of Secondary Memory 

 True Characteristics: 
o Non-volatile. 
o Larger storage capacity. 

o Slower and cheaper than primary memory. 
o Cannot be directly accessed by the CPU. 
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216. Email Features 

 Definition: Exchange of messages encoded in ASCII text. 
 Key Point: Email is one of the earliest and most popular internet activities.  

 

217. Left Panel in PowerPoint 

 Components: 
o Slides Panel. 

o Outline Panel.  
 Notes Panel: Located at the bottom of the presentation.  

 

218. First General-Purpose Electronic Computer 

 Name: ENIAC (Electronic Numerical Integrator and Calculator).  
 Inventors: J. Presper Eckert and John Mauchly.  
 Purpose: Solving numerical problems. 

 

219. Theme Tab in PowerPoint 

 Location: Design Tab. 
 Function: Allows customization of fonts, colors, and backgrounds.  

 

220. Interrupt 

 Definition: Signal emitted by hardware or software requiring immediate attention.  
 Function: Temporarily stops a process to handle a higher-priority task. 

 

221. SDRAM 

 Full Form: Synchronous Dynamic Random-Access Memory. 
 Key Features: 

o Synchronizes with the system clock.  
o Supports up to 133 MHz system bus cycling.  

o Faster than asynchronous DRAM. 

 

222. PHP 

 Full Form: Hypertext Preprocessor. 
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 Use: Develops static websites, dynamic websites, or web applications.  

 File Extension: .php. 

 

223. Shortcut Key to Close Programs 

 Key: Ctrl + W. 
 Other Shortcuts: 

o Ctrl + Shift + Esc: Open Task Manager.  
o Ctrl + R: Refresh window. 

o Ctrl + Z: Undo action. 

 

224. Second-Generation Computers 

 Period: 1959-1965. 
 Component: Transistors. 

 Features: Cheaper, smaller, more reliable, and faster than vacuum tubes.  
 Programming Languages: FORTRAN, COBOL. 
 Storage: Magnetic cores (primary), magnetic tape/disks (secondary).  

 

225. Switching Tabs 

 Key Combination: Alt + Tab for applications, Ctrl + Tab for browser tabs. 

 

226. Fourth-Generation Computers 

 Period: 1971-1980. 
 Components: VLSI circuits. 
 Examples: STAR 1000, DEC 10, PDP 11.  

 

227. Operating System Examples 

 Examples: Windows, Linux, Android. 
 Not OS: MS Office, Notepad, games. 

 

228. Worm Virus 

 Definition: Malicious software that replicates and spreads without a host.  
 Key Feature: Exploits security vulnerabilities. 
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229. Flash Memory 

 Examples: Pen drives, memory cards. 
 Type: Non-volatile electronic data storage. 

 

230. High-Level and Object-Oriented Languages 

 Examples: Java, C++, Python. 
 Not Both: C (not object-oriented). 

 

231. First-Generation Computers 

 Component: Vacuum Tubes. 
 Examples: ENIAC. 

 

232. CPU Core 

 Definition: Basic computational unit of the CPU. 
 Types: Dual-core, quad-core, octa-core. 

 

233. PowerPoint Shortcuts 

 New Slide: Ctrl + M. 
 New Presentation: Ctrl + N. 

 Close PowerPoint: Ctrl + Q. 

 

234. Software Patch 

 Definition: Code to fix issues in a program after installation.  
 Availability: Developer’s website. 

 

235. Point-to-Point Network 

 Definition: Connects exactly two hosts in a dedicated manner.  
 Key Point: Direct connection or logical connection through intermediate devices.  
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236. Network Database Model 

 Definition: Links multiple records to a single owner file.  
 Structure: Upside-down tree with branches for member information.  

 

237. Ports in Computers 

 Definition: Slots for connecting external devices. 
 Examples: Mouse, keyboard, monitor, microphone. 

 

238. Logic Bomb 

 Definition: Malicious code triggered by specific conditions.  
 Other Name: Time bomb (triggered on specific dates).  

 

239. Computer Bus 

 Definition: Physical wires transferring data, addresses, and control signals.  
 Types: 

o Data Bus: Transfers data. 
o Address Bus: Transfers memory addresses. 

o Control Bus: Transfers control signals. 

 

240. Device Driver 

 Definition: Software enabling hardware components to function. 
 Examples: Drivers for printers, displays, CD-ROM readers. 

 

241. VGA (Video Graphics Array) 

 Full Form: Video Graphics Array.  
 Developer: IBM. 

 Features: 
o Resolution: 640 x 480 (16 colors, 60 Hz refresh rate).  

o Lower resolution: 320 x 200 (256 colors). 
o Uses analog signals, limiting quality and resolution. 
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242. Port Numbers 

 Definition: Logical channel for sending/receiving data to/from applications.  
 Bit Size: 16-bit integer. 

 Function: Identifies specific applications on a host with multiple applications running. 

 

243. MICR 

 Full Form: Magnetic Ink Character Recognition.  

 Use: Processes cheques rapidly using machine-readable codes. 
 Code Structure: Nine-digit code with transaction and bank details.  

 

244. URL Components 

 Example URL: http://in.oliveboard.com/news/index.html 
o Server Type: http (denotes protocol). 
o Hostname: in.oliveboard.com. 

o Directory Name: news. 
o File Name: index.html. 

 

245. Vulnerability Scanner 

 Definition: Program that identifies weaknesses in computers, networks, or applications.  
 Features: Can perform authenticated or unauthenticated scans.  

 

246. Toggle Split Screen in MS Word 

 Shortcut Key: Alt + Ctrl + S. 
 Other Shortcuts: 

o Ctrl + W: Close current document.  
o Ctrl + S: Save current document.  

o Ctrl + K: Add hyperlink. 

 

247. Shortcut Menu in MS Word 

 Key Combination: Shift + F10. 
 Other Useful Shortcuts: 

o Shift + F7: Opens Thesaurus.  
o Ctrl + F2: Print Preview. 

o F1: Help. 



 

41 

 

 

248. Save Document Shortcut 

 Key Combination: Shift + F12. 
 Other Shortcuts: 

o Shift + F3: Change text case. 

o Ctrl + Shift + F6: Switch between open Word documents.  
o Ctrl + Shift + F12: Print document.  

 

249. Absolute Cell Reference in Excel 

 Definition: Cell reference that does not change unless moved or copied.  
 Format: Includes dollar sign ($), e.g., $A$1. 

 

250. IEEE 802.3 (Ethernet Standards) 

 Definition: Standards for Ethernet-based networks. 
 Key Points: 

o Developed by Institute of Electrical and Electronics Engineers (IEEE).  
o Defines physical layer and MAC (Media Access Control) of the data link layer.  

o Used in Local Area Network (LAN) technologies.  

Study Notes for Competitive Exams  

(Important information highlighted in bold) 

 

251. MS Office Tab Features 

 Insert Tab: Used to insert various features into a document.  
 Groups under Insert Tab: 

o Pages Group: Cover Page, Blank Page, Page Break. 

o Tables Group: Tables. 
o Illustrations Group: Pictures, Shapes, Smart Art, etc.  

o Media and Links Group: Hyperlink, Bookmark, etc. 
o Header and Footer Group: Page Number, Header, Footer.  
o Text Group: Text Box, Word Art, etc. 

o Symbol Group: Equation, Symbol. 

 

252. Decimal Number System 

 Base: Decimal number system is a base-10 system with digits from 0 to 9. 
 Radix/Base: Number of digits in a system. 
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 Positional Value System: Value depends on digit's position.  

 

253. Least Vulnerable Operating Systems  

 Linux and Mac are less vulnerable to virus attacks.  
 Require privileged access for malware to run. 

 Windows : Most recommended for desktops but more prone to malware compared to Linux.  

 

254. Features of Application Software  

 Developed using C++, Java, Visual Basic, etc. 
 Always depends on operating systems . 

 Runs when a user initiates.  
 Examples: Photoshop, VLC Player. 

 

255. File Extensions for Applications  

 MS Word: .doc, .docx 
 MS Excel: .xls, .xlsx 

 MS PowerPoint: .ppt, .pptx 
 MS Access: .accdb 

 

256. Levels of Data Abstraction 

 Highest Level: View Level (External Level).  

 Simplifies complexity for users by hiding logical details.  

 

257. Botnet 

 A network of internet-connected devices running one or more bots. 

 Used for: 
o Distributed Denial-of-Service (DDoS) attacks. 

o Spamming. 
o Data theft. 

 

258. MIME 

 Multipurpose Internet Mail Extension (MIME): Allows non-text email attachments like spreadsheets, 
audio, and video to be sent over the internet.  
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259. Father of Modern Digital Computer 

 Charles Babbage: Inventor of the Analytical Engine. 

 

260. MS Excel Shortcut Keys 

 Ctrl + Shift + @: Apply time format. 
 Ctrl + Shift + #: Apply date format. 

 Ctrl + Shift + %: Apply percentage format.  
 Ctrl + Shift + $: Apply currency format. 

 

261. TCP in Networking  

 T in TCP: Transmission Control Protocol. 

 Part of the Internet Protocol Suite  for data transmission. 

 

262. Charts in MS Excel 

 Line Graph: Tracks changes over time. 

 Bubble Chart: Displays three variables using bubble size.  
 Pie Chart: Shows percentage or proportional data.  

 Bar Chart: Compares data points across subgroups.  

 

263. Embedding  

 Embedding: Adding social media content to a webpage using HTML code. 

 

264. Tree Topology  

 Tree Topology: Requires at least three levels in a hierarchy. 
 Combines star and bus topologies. 

 

265. Memory Units in Order 

 Order: KB < MB < GB < TB. 
 1 Byte = 8 Bits. 

 1 Kilobyte (KB) = 1024 Bytes. 
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 1 Megabyte (MB) = 1024 Kilobytes. 

 1 Gigabyte (GB) = 1024 Megabytes. 
 1 Terabyte (TB) = 1024 Gigabytes. 

 

266. Host in Networking  

 A Host: Any device connected to a network, assigned a unique network address. 

 

267. Modular Programming  

 Modular Programming: Divides functionality into independent modules for flexibility and reusability.  

 

268. Memory Types and Examples 

 Optical Memory: CD-ROM, DVD, Blu-ray. 
 Magnetic Memory: Hard Disk Drive, Floppy Disk. 

 Flash Memory: Pen Drives, Memory Cards. 

 

269. Catfish 

 Catfish: A person creating a fake online profile to deceive others for various motives like financial gain or 
emotional manipulation. 

 

270. Monitor Examples 

 Types: LED, TFT, LCD. 
 Modern monitors are flat-screen LCDs, lighter and energy-efficient compared to older CRT monitors. 

 

271. MS Office Tab Features 

 Insert Tab: Used to insert various features into a document.  

 Groups under Insert Tab: 
o Pages Group: Cover Page, Blank Page, Page Break. 
o Tables Group: Tables. 

o Illustrations Group: Pictures, Shapes, Smart Art, etc.  
o Media and Links Group: Hyperlink, Bookmark, etc. 

o Header and Footer Group: Page Number, Header, Footer.  
o Text Group: Text Box, Word Art, etc. 
o Symbol Group: Equation, Symbol. 
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272. Decimal Number System 

 Base: Decimal number system is a base-10 system with digits from 0 to 9. 
 Radix/Base: Number of digits in a system. 

 Positional Value System: Value depends on digit's position.  

 

273. Least Vulnerable Operating Systems 

 Linux and Mac are less vulnerable to virus attacks.  
 Require privileged access for malware to run. 

 Windows : Most recommended for desktops but more prone to malware compared to Linux.  

 

274. Features of Application Software  

 Developed using C++, Java, Visual Basic, etc. 
 Always depends on operating systems . 
 Runs when a user initiates.  

 Examples: Photoshop, VLC Player. 

 

275. File Extensions for Applications  

 MS Word: .doc, .docx 
 MS Excel: .xls, .xlsx 
 MS PowerPoint: .ppt, .pptx 

 MS Access: .accdb 

 

276. Levels of Data Abstraction 

 Highest Level: View Level (External Level).  
 Simplifies complexity for users by hiding logical details.  

 

277. Botnet 

 A network of internet-connected devices running one or more bots. 

 Used for: 
o Distributed Denial-of-Service (DDoS) attacks. 
o Spamming. 

o Data theft. 
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278. MIME 

 Multipurpose Internet Mail Extension (MIME): Allows non-text email attachments like spreadsheets, 
audio, and video to be sent over the internet.  

 

279. Father of Modern Digital Computer 

 Charles Babbage: Inventor of the Analytical Engine. 

 

280. MS Excel Shortcut Keys 

 Ctrl + Shift + @: Apply time format. 

 Ctrl + Shift + #: Apply date format. 
 Ctrl + Shift + %: Apply percentage format.  

 Ctrl + Shift + $: Apply currency format. 

 

281. TCP in Networking  

 T in TCP: Transmission Control Protocol. 

 Part of the Internet Protocol Suite  for data transmission. 

 

282. Charts in MS Excel 

 Line Graph: Tracks changes over time. 
 Bubble Chart: Displays three variables using bubble size.  

 Pie Chart: Shows percentage or proportional data. 
 Bar Chart: Compares data points across subgroups.  

 

283. Embedding  

 Embedding: Adding social media content to a webpage using HTML code. 

 

284. Tree Topology  

 Tree Topology: Requires at least three levels in a hierarchy. 
 Combines star and bus topologies. 
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285. Memory Units in Order 

 Order: KB < MB < GB < TB. 
 1 Byte = 8 Bits. 

 1 Kilobyte (KB) = 1024 Bytes. 
 1 Megabyte (MB) = 1024 Kilobytes. 
 1 Gigabyte (GB) = 1024 Megabytes. 

 1 Terabyte (TB) = 1024 Gigabytes. 

 

286. Host in Networking  

 A Host: Any device connected to a network, assigned a unique network address. 

 

287. Modular Programming  

 Modular Programming: Divides functionality into independent modules for flexibility and reusability.  
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288. Memory Types and Examples 

 Optical Memory: CD-ROM, DVD, Blu-ray. 

 Magnetic Memory: Hard Disk Drive, Floppy Disk. 
 Flash Memory: Pen Drives, Memory Cards. 

 

289. Catfish 

 Catfish: A person creating a fake online profile to deceive others for various motives like financial gain or 
emotional manipulation. 

 

290. Monitor Examples 

 Types: LED, TFT, LCD. 

 Modern monitors are flat-screen LCDs, lighter and energy-efficient compared to older CRT monitors. 
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291. Examples of Batch Operating System 

 Batch Operating System: Groups similar jobs with the same requirements into batches for processing. 

 Examples: Payroll System, Bank Statements. 

 

292. Signature File in Emails 

 Signature File : A short text file automatically appended at the end of emails.  
 Commonly includes: User’s name, phone number, company, and company URL. 

 

293. Daughterboard 

 Daughterboard: A circuit board that plugs into and extends the circuitry of another circuit board.  
 It may extend: 

o Motherboard. 
o Another board, like a sound card. 

 Also known as: Daughter Card, Piggyback Board, Riser Card, Mezzanine Board. 

 

294. MS Access Database Objects 

 Form: Used to create a user interface for the database, displaying live data for easier data entry or editing.  
 Other objects: 

o Macros: Mini programming constructs for automating commands like searching or formulas.  

o Modules: Procedures written using VBA. 
o Query: Selects, sorts, and filters data based on search criteria.  

 

295. OMR (Optical Mark Recognition) 

 M in OMR: Mark. 
 Scans documents to read marked fields and transmit data into computers.  

 Applications: Educational tests, surveys, assessments, and multiple-choice forms. 

 

296. Trackball Features 

 Trackball: Always stationary, unlike a mouse. 
 Functions: 

o Input device used in notebooks or laptops. 
o Requires less space than a mouse.  
o Shapes: Ball, Button, Square. 
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297. Windows Shake Feature  

 Shake: Focuses on one open window by minimizing others. 
o Shake the title bar to minimize other windows.  

o Shake again to restore minimized windows.  
 Snap: Organizes windows by dragging them to screen edges (both vertically and horizontally).  

 

298. MICR (Magnetic Ink Character Recognition) 

 MICR: An input device, not an output device. 

 Usage: Banking industry for cheque processing. 

 

299. Fourth Generation of Computers  

 Time Period: 1971-1980. 
 Features: 

o Used VLSI (Very Large Scale Integrated) circuits with about 5000 transistors on a single chip.  

o Enabled time sharing, real-time networks, and distributed operating systems. 
o Introduction of microcomputers and the PC revolution. 

o Supported high- level languages like C, C++, and DBASE. 
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300. UTP Cables (Unshielded Twisted Pair) 

 UTP Cables: Composed of 8 wires twisted into 4 pairs to prevent malfunctions. 

 Connectors: RJ45 plugs. 
 Function: Transmit signals effectively by reducing interference.  

 

301. First General-Purpose Computer for Commercial Use 

 UNIVAC (Universal Automatic Computer): First commercially available computer.  
 Developed by Eckert-Mauchly Computer Company. 

 ENIAC: First electronic computer for general purposes, invented by J. Presper Eckert and John 

Mauchly. 

 

302. Notes and Graphics in PowerPoint 

 Notes Pane: Adds notes and graphics for the current slide and allows printing notes.  
 Slides Pane: Displays slide thumbnails for viewing and editing.  

 Outline Pane : Shows text from the slides. 
 Task Pane: Provides access to commands (e.g., new presentation, help). 

 AutoContent Wizard: Helps create presentations with a structured framework.  

 

303. Drop Cap in MS Word 

 Drop Cap: A decorative element used at the start of a paragraph or section in Word documents.  

 

304. Indentation in MS Word 

 Use the Tab key to indent the first paragraph of a document.  
 Adjust indentation via the Paragraph dialog box for more control. 

 

305. Session Initiation Protocol (SIP) 

 SIP: A signaling protocol for Voice Over Internet Protocol (VoIP). 
 Supports voice calls, video conferencing, instant messaging, and media distribution. 

 Establishes a direct connection between private telephone systems and public telephone networks.  

 

306. Web Hosting and Non-Web Hosting Services 

 Web Hosting: Services like Bluehost, HostGator, GoDaddy, SiteGround, and DreamHost.  
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 DuckDuckGo: Not a web hosting service but a search engine prioritizing privacy. 

 

307. EPROM (Erasable Programmable Read-Only Memory) 

 EPROM : Retains data even when power is off.  
 Data erased using ultraviolet light. 

 Consists of floating-gate transistors. 

 

308. Internet of Things (IoT) 

 IoT: Concept of connecting any device with an on/off switch to the Internet and other devices.  
 Forms a network of connected devices sharing data.  

 

309. AGP Slot on Motherboard 

 A in AGP: Accelerated Graphics Port. 

 Provides a direct connection between the graphics card and system memory for better performance.  

 

310. Components of Computer Speaker 

 Made up of cone, iron coil, magnet, and housing. 
 Converts electrical signals into sound waves.  

 

311. MIMO (Multiple-Input Multiple-Output) 

 MIMO: Wireless technology with multiple transmitters and receivers for higher data transfer speeds.  
 Supported by devices using 802.11n standards. 

 

312. Merging Workbooks in MS Excel 

 Merging: Combines copies of workbooks worked on independently. 

 

313. Drop-Down Menu (Pull-Down Menu) 

 A menu of commands or options appears when selected with a mouse.  

 Located at the top of the screen; options appear below.  
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314. Primary Memory Examples 

 Includes Read-Only Memory (ROM) and Random-Access Memory (RAM). 
 Located close to the CPU for faster data access.  

 

315. Packets in Broadcast Network  

 Packets: Short messages sent by any machine, received by all others in the network.  

 Used in broadcast networks with a shared communication channel.  

 

316. Flooding in Mesh Topology  

 Flooding: Data is transmitted to all nodes without routing logic.  
 Another technique: Routing, directs data using the shortest path.  

 

317. Swapping in Computers 

 Swapping: Enables execution of programs and manipulation of files larger than main memory. 
 Exchanges data between main memory and disk storage. 

 

318. Cloud Storage 

 Cloud Storage : Stores data on the Internet via a cloud provider. 

 Benefits: Agility, global scale, durability, and anytime, anywhere access. 

 

319. Universal Gates 

 NAND and NOR gates: Called universal gates as they can implement any Boolean expression.  

 

320. Cookies in Browsers  

 Cookies: Small text files stored by web browsers to track user activity.  
 Functions: Resume activity, remember login credentials, and store user preferences.  
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321. Application to Convert HTML and XML 

 Web Browser: A free software application used to view web pages, graphics, and online content.  
 Converts HTML and XML into readable documents. 

 Examples: Internet Explorer, Firefox, Google Chrome, Netscape Navigator, Safari. 

 

322. Incorrectly Matched Pairs 

 Google Hangouts: Cross-platform instant messaging by Google.  

 Microsoft Access: Database management system by Microsoft.  
 Incorrect Pair: Option D. 

 

323. Shortcut to Close Application 

 Alt + F4: Closes the currently active window. 
 Example: Closes the browser and all open tabs when pressed.  

 

324. Binary to Decimal Conversion 

 Binary Number: 1111. 
 Decimal Equivalent: 15. 

Base Number System 

 Binary: Base 2 
 Octal: Base 8 
 Decimal: Base 10 

 Hexadecimal: Base 16 

 

325. Types of Networks 

 Local Area Network (LAN): Connects devices in a single physical location (e.g., building or office).  
 Wide Area Network (WAN): Connects multiple LANs across large geographic areas.  

 Metropolitan Area Network (MAN): Connects computers within a metropolitan area.  

 

326. Random-Access File 

 Accessed directly without reading other files first.  

 Example: Hard Drives use direct access, while tape drives use sequential access. 
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327. Concatenate Function in Excel 

 Concatenate Function: Combines data from two or more cells without merging them.  
 Syntax: CONCATENATE(text1, [text2, ..., text_n]). 

 Replaced by Concat in Excel 2016. 

 

328. Uninterrupted Power Supply (UPS) 

 Provides battery backup during power outages. 

 Allows time to save work and shut down safely.  

 

329. Hardware Interrupts 

 Maskable Interrupt: Can be delayed if higher priority interrupts occur.  
 Non-Maskable Interrupt: Cannot be delayed and is processed immediately.  

 

330. Mobile Phishing (Smishing) 

 Fraudulent SMS or in-app message with malicious links. 
 Used to steal personal information or install malware.  

 

331. Transport Layer in OSI Model 

 Ensures complete and reliable delivery of data packets. 
 Functions: Error control, flow control, congestion control. 
 Handles packet segmentation and reassembly. 

 

332. Copying Cells in Excel 

 Ctrl + R : Copies the content from the left cell.  
 Ctrl + D : Copies the content from the cell above.  

 

333. Open-Source Software (OSS) 

 Makes source code available to all users for free. 
 Rights: Study, change, and distribute the software.  
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334. Human-Computer Interface (HCI) 

 H stands for Human. 
 Example: Keyboard, mouse are HCI devices. 

 

335. Shortcut to Close Workbook in Excel 

 Ctrl + W: Closes the workbook. 
 Ctrl + O: Opens a workbook. 

 

336. Masked ROMs (MROM) 

 ROM: Non-volatile memory storing permanent instructions.  
 Masked ROMs: Early ROMs with pre-programmed data. 

 

337. Blue Screen of Death (BSoD) 

 S stands for Screen. 
 Indicates a fatal system error causing a system crash. 

 

338. Non-Antivirus Software 

 Examples of Antivirus Software: McAfee, Norton, Avira. 
 Keefsafe: Not an antivirus software; a photo vault app.  

 

339. Hotspot (Wi-Fi) 

 Wireless access points providing network/Internet access to devices. 
 True for all statements in the question. 

 

340. Windows 10 Shortcuts 

 Windows + I: Open Settings. 
 Windows + M : Minimize all windows. 
 Windows + S: Open search. 

 Windows + X: Open Quick Link menu. 
 Windows + Tab: Open Task View. 
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341. Rootkit 

 A rootkit is a malicious software bundle  providing unauthorized access to a computer.  
 Used for remote access, data theft, and system manipulation.  

 Hard to detect and conceals its presence. 

 

342. Base of Octal Number System 

 Octal System Base: 8. 

 Other systems: 
o Decimal: Base 10. 
o Binary: Base 2. 

o Hexadecimal: Base 16. 

 

343. RJ-45 Connector 

 Standard connector for unshielded twisted pair cabling. 

 RJ stands for Registered Jack. 
 Used in network connections, resembling a larger telephone connector.  

 

344. Ping Command 

 Ping: Verifies if an IP address exists and accepts requests.  
 Sends an ICMP Echo Request and waits for a reply. 
 Used for troubleshooting connectivity and response times.  

 

345. HTML Headings 

 <h1>: Defines the most important heading in HTML. 
 <h6>: Defines the least important heading. 

 

346. RAM 

 Volatile memory: Data is wiped when power is off.  
 Used to store data temporarily while the computer is running.  
 Faster than secondary storage. 
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347. Types of Firewalls 

 Network Firewall: Monitors traffic between networks.  
 Host-based Firewall: Monitors traffic to and from a single computer.  

 

348. Botnet 

 Botnet: Group of devices connected for malicious purposes. 
 Controlled by a third party to transmit malware, spam, or launch attacks.  

 Also called a zombie army. 

 

349. DSL in Broadband 

 Digital Subscriber Line (DSL): 
o Internet provided through 2-wire copper telecommunication lines . 

o Allows simultaneous calls and internet access. 
o Maintains high-speed internet. 

 

350. Spider (Web Crawler) 

 Program designed to browse the World Wide Web systematically. 
 Purpose: Indexing websites. 
 Also known as a web bot, web crawler, or web robot. 

 

351. Master Boot Record (MBR) 

 Found at the beginning of a hard drive . 
 Contains partition information and a boot record. 

 

352. Video Conferencing Software 

 Webex: Developed by Cisco. 
o Used for video conferencing, screen sharing, and webinars.  

 Other examples: 

o Google Meet: By Google. 
o Microsoft Teams: By Microsoft. 
o Zoom: By Zoom Video Communications.  

o GoToMeeting: By LogMeIn. 
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353. Switched-Mode Power Supply (SMPS) 

 Provides regulated voltage to the motherboard. 
 Uses a switching regulator for efficiency and reduced power loss.  

 

354. Excel Preprogrammed Formula 

 Function: Predefined formulas in Excel.  
 Example: SUM, AVERAGE, etc. 

 

355. MS Office Shortcuts  

 Ctrl + E: Aligns text to the center.  
 Ctrl + J: Justifies text. 
 Ctrl + B : Bold. 

 Ctrl + I: Italic. 
 Ctrl + K: Insert hyperlink. 

 

356. OLED Monitors  

 O stands for Organic in Organic Light Emitting Diode . 
 No need for backlight, saving power and space.  

 

357. Alt + Tab 

 Switches between open applications.  

 

358. Erasing EPROM 

 EPROM : Erased by intense ultraviolet light. 
 Stands for Erasable Programmable Read-Only Memory. 

 

359. Excel Sheet Tab 

 Displays the name of the worksheet. 
 Located at the bottom of the Excel window. 
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360. Compiler in C++ 

 Converts C++ instructions into object code or machine code. 
 Enables program execution by translating human-readable code. 

 

361. Functions NOT Performed by MS Excel 

 MS Excel is used to: 
o Organize and present data systematically.  

o Perform arithmetic operations and create graphs/charts. 
o Common Functions: SUM, TEXT, VLOOKUP, AVERAGE, CONCATENATE. 

 AUTOGRAPH FUNCTION is NOT performed by MS Excel. 

 File extension: .xls. 

 

362. HTTP Error Codes 

 503 Service Unavailable: Server not ready to handle the request (e.g., maintenance or overload).  

 Other HTTP Codes: 
o 400 Bad Request: Incorrect URL or restricted page. 
o 403 Forbidden: Access requires a username/password.  

o 404 Not Found: Web page cannot be found on the server.  

 

363. Database Schema 

 Database Schema: Blueprint of the structure of a database.  
 Defines organization and relationships among data.  

 

364. MS Word Spelling Error Indication 

 Red Wavy Line: Indicates a misspelled word. 
 Automatically checks for spelling/grammar errors.  

 

365. Ribbon in MS PowerPoint 

 Ribbon: Strip of buttons (tabs) across the top of the window.  
 Organizes menus and toolbars into a single row.  
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366. Disk Performance Metrics 

 Seek Time : Time for the read/write head to move between tracks.  
o Lower seek time = Better performance. 

 Rotational Latency: Time to rotate to the requested sector.  

 

367. Reverse Proxy Server 

 Sits behind a firewall and directs client requests to the backend server. 

 Provides abstraction and control for smooth network traffic.  

 

368. Deadlock 

 Deadlock: Two programs prevent each other from accessing a shared resource, halting both programs.  

 

369. File Restrictions in Emails 

 Executable (.exe) files cannot be attached to emails due to security risks.  
 Allowed file types: .pdf, .xls, .ppt, .mp4. 

 

370. Hard vs. Soft Email Bounce 

 Hard Bounce : Permanent rejection due to invalid or non-existent email addresses. 
 Soft Bounce : Temporary issue (e.g., full inbox, server down, large message).  

 

371. Authentication 

 Authentication: Verifying identity via username and password.  
 Distinct from authorization (granting access based on identity).  

 

372. Macro Instruction 

 Macro: Single line of code producing multiple machine language instructions.  
 Expands into actual instruction details when executed.  

 



 

62 

 

373. Third-Generation Computers 

 Replaced transistors with integrated circuits (ICs). 
 Features: Nanosecond computation, time-sharing, multi-programming. 

 Examples: IBM-360 series, Honeywell-6000 series, PDP, IBM-370/168. 

 

374. Keyboard Bumps  

 Bumps on 'F' and 'J' keys ensure optimal hand placement for typing.  

 Helps identify keys without looking.  

 

375. Address Register 

 Address Register: 12-bit register storing memory location addresses for data or instructions.  

 

376. VGA Connector 

 VGA: Stands for Video Graphic Array. 
 15-pin connector used for video output on computers, projectors, etc.  

 

377. Engrave in MS Word 

 Engrave: Formatting text to appear sunken into the page.  
 Opposite of embossed text. 

 

378. Bridge Devices in LAN 

 Bridge : Transmits frames between LANs. 
 Operates at Layer 2 (Data Link Layer) of OSI. 

 Types: 
o Wireless Bridge: Supports Wi-Fi access points. 
o Wi-Fi Ethernet Bridge: Connects Ethernet devices to Wi-Fi networks. 

 

379. Excel Shortcut Keys 

 Alt + =: AutoSum. 
 Ctrl + Shift + U: Expand/collapse formula bar. 

 Ctrl + Home : Go to the first cell. 
 Ctrl + End: Go to the last cell. 
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 Ctrl + ~: Show/hide all formulas. 

 

380. BCC in Email 

 Blind Carbon Copy (BCC): 
o Recipients cannot see who else received the email.  

 

381. Function Keys in MS Word 

 F9: Update selected fields. 
 Other Keys: 

o F7: Spell Check. 
o F8: Extend selection. 

o F10: Show Key Tips. 
o F11: Go to the next field. 

 

382. Non-Antivirus Software 

 MYSQL is NOT an antivirus. 
 Examples of Antivirus: Programs designed to detect, quarantine, and remove viruses.  

 

383. Cache Memory 

 Acts as a buffer between RAM and CPU. 
 Holds frequently requested data for quick access.  
 Extremely fast and synchronizes with high-speed CPUs. 

 

384. NOS (Network Operating System) 

 Used for: 
o Specialized devices like routers, switches, and firewalls. 
o Enabling shared access to files, printers, and other resources on a LAN. 

 

385. Kernel 

 Kernel: Core of an Operating System. 
 Manages operations of memory and CPU time.  
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386. Technology Used in Bitcoin 

 Blockchain: Technology enabling the existence of cryptocurrency, including Bitcoin.  

 

387. Apple's Presentation Software 

 Keynote: Pre-installed on most Apple devices for creating presentations.  

 

388. Third Generation Computers 

 Integrated Circuits (ICs) introduced as processors. 
 Features: 

o Smaller size, superior performance. 
o Higher storage and calculating speeds.  
o Developed by T.S. Kilby. 

 

389. Gutter Margin 

 Gutter Margin: Additional margin in page layout to compensate for binding.  

 

390. Multicast Group IP Range 

 Class D IP Range: Reserved for Multicast groups. 

 

391. SEO (Search Engine Optimization) 

 O stands for Optimization. 
 Process to improve quality and quantity of traffic to websites via organic search results.  

 

392. Placeholder in PowerPoint 

 Placeholder: Pre-formatted container on a slide for text, graphics, or video. 
 Found in Slide Master View for consistent formatting.  

 

393. Trojan Horse 

 Malware disguising itself as legitimate software.  
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 Can install harmful programs while appearing genuine.  

 

394. DHCP 

 Dynamic Host Configuration Protocol: 
o Provides IP addresses and configuration automatically.  
o Reduces manual configuration errors.  

 

395. First Programmable Processor 

 Intel 4004: Designed by Intel Corporation in 1969. 
 First general-purpose programmable processor.  

 

396. Relational Database Programming Language 

 FoxPro: A relational database procedural programming language.  
 Initially developed by Fox Software, later acquired by Microsoft.  

 

397. Measuring Data Speed 

 Baud: Unit for symbol rate or modulation rate in symbols per second.  

 

398. Ipsilon Networks 

 Parent Organization: Nokia. 
 Developed IP-Switching, the first version of label-switching. 

 

399. Pre-Boot Reboot Command 

 Ctrl+Alt+Delete: Command to reboot a computer in the pre-boot environment. 

 

400. Modifier Keys 

 Modifier keys temporarily modify the normal action of another key.  
 Examples: Shift, Ctrl, Alt. 

 Alone, they do not trigger any action.  

 



 

66 

 

401. Maskable and Non-Maskable Interrupts 

 Maskable Interrupts: Can be ignored by instructing the CPU. 
 Non-Maskable Interrupts (NMI): 

o Cannot be ignored. 
o Used for critical hardware errors.  

 

402. Encryption in Networks  

 Secure Crypto-Processor: 
o Encrypts every message sent over a network.  
o Ensures high- level security. 

 

403. Non-Programming Language 

 Microsoft Bing: A web search engine. 
 Examples of programming languages: Python, C, C++, Java. 

 

404. Modes of Transmission 

 Simplex: Unidirectional (e.g., Keyboard to Monitor).  
 Half-Duplex: Two-way but one at a time (e.g., Walkie-Talkie). 
 Full-Duplex: Two-way simultaneously (e.g., Telephone).  

 

405. Real-Time Safety Monitoring Technology 

 Edge Computing: 
o Brings computation closer to the data source.  
o Used in oil and gas industries for real-time monitoring. 

 Other technologies: 
o Big Data Analytics : Processes large, diverse datasets.  

o Artificial Intelligence (AI): Mimics human intelligence. 
o Virtual Reality (VR): Simulates interactive 3D environments.  

 

406. MS Excel Shortcut to Select Entire Row 

 Shift + Spacebar: Selects the entire row. 
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407. Line Matrix Printers 

 Use mechanical pressure to print on multi-part forms (e.g., carbon paper).  
 Prints lines of dots rapidly, achieving over 1000 lines per minute.  

 

408. Bandwidth 

 Amount of data transmitted in a fixed time.  
 Measured in bits per second (bps) or Hertz for analog devices. 

 

409. Fathers of Programming Languages 

 C++: Invented by Bjarne Stroustrup. 
 Others: 

o C: Dennis Ritchie. 

o Python: Guido van Rossum. 
o Java: James Gosling. 

 

410. Digital Footprint 

 Trail of data left when using the internet.  
 Includes websites visited, emails sent, and online submissions.  

 

411. Watermark 

 Watermark: Ghost text or image behind main text on a page.  
 Used in documents like stamps and currency to prevent counterfeiting.  

 

412. Advantages of Local Area Network (LAN) 

 High bandwidth, inexpensive transmission medium, easy maintenance.  
 Disadvantage : Cannot cover large geographic areas.  

 

413. Valid Email Address 

 Components: 
o Recipient name. 

o @ symbol. 
o Domain name and top- level domain (e.g., .com, .org, .net). 
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 Example of Invalid Email: Domain name followed by @ instead of the top- level domain. 

 

414. IEEE Ethernet Standard 

 802.3: Standard for Ethernet. 
 Other IEEE Standards: 

o 802.2: Logical Link Control. 

o 802.5: Token Ring. 
o 802.11: Wireless networks. 

 

415. Data Integrity 

 Ensures overall accuracy, completeness, and consistency of data. 
 Prevents data redundancy and inconsistency.  

 

416. Table Relationships in MS Access 

 Types: 
o One-to-Many. 
o Many-to-Many. 
o One-to-One. 

 Any relationship other than these is invalid. 

 

417. Supercomputers (Number Crunchers) 

 Perform large mathematical calculations.  
 Measured in Floating-Point Operations Per Second (FLOPS). 
 Example: Used in weather forecasting, scientific simulations.  

 

418. Dynamic Web Pages 

 Dynamic Web Page : Displays different content each time it is viewed.  
 Examples: 

o Login pages. 

o Shopping carts. 
o Submission forms. 

 

419. Database Management System (DBMS) 

 Organizes tables into normal forms to reduce anomalies: 
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o First Normal Form (1NF) 

o Second Normal Form (2NF) 
o Third Normal Form (3NF) 
o Boyce-Codd Normal Form (BCNF). 

 

420. Nature of Computers 

 Versatile : Perform multiple types of work simultaneously.  
 Diligence : Operates continuously without errors or fatigue.  

 

421. Headers and Footers 

 Used to add information like: 
o Page numbers, date/time, logos, document title, or author's name. 

 Appear in the top or bottom margins of a document. 

 

422. Storage Capacity of 3.5" Floppy Disk 

 1.44 megabytes. 

 

423. Star Topology 

 All devices connect to a central hub via cables. 
 Hub types: 

o Passive Hub: Broadcasts data. 
o Active Hub: Intelligent. 

 

424. Developer of PASCAL Language 

 Niklaus Wirth: Developed Pascal to teach programming techniques.  

 

425. IBM PC DOS 

 IBM sold PC DOS between 1981–2000. 
 Initially branded as MS-DOS, later became IBM’s independent product.  
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426. DRAM 

 Dynamic Random Access Memory (DRAM): 
o Requires frequent refreshing to maintain data.  

o Used for program code and data in PCs and servers.  

 

427. Hard Disks vs. Diskettes 

 Hard Disks: 

o More expensive. 
o Store and retrieve large amounts of digital data.  
o Use rapidly rotating magnetic platters.  

 

428. Print Shortcut 

 Ctrl + P: Keyboard shortcut to print documents in Windows.  

 

429. Drag and Drop 

 Action of dragging the mouse to move an object and dropping it at the desired location. 

 

430. File Allocation Table (FAT) 

 T stands for Table. 
 A simple file system architecture used for organizing and storing files.  

 

431. Read-Only Memory (ROM) 

 Non-volatile memory. 
 Used for storing firmware or application software.  

 

432. First Commercial Modem 

 Dataphone: Introduced by AT&T for converting digital data to analog signals. 
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433. Hyperlink 

 A reference to data that a user can follow by clicking or hovering.  
 Points to documents or specific elements within a document.  

 

434. Sheet-Fed Scanners 

 Used for scanning papers only. 
 Not suitable for books or 3D objects. 

 

435. Point-of-Sale (POS) Terminal 

 Functions: 
o Acts as a cash register and computer terminal.  
o Tracks orders, manages inventory, and processes payments.  

 

436. AVI Format 

 Audio Video Interleave (AVI): 
o Introduced by Microsoft in 1992. 

 

437. SDRAM 

 Synchronous Dynamic Random-Access Memory: 
o Synchronizes with the system clock for higher speeds (up to 133 MHz). 

 

438. Superscript 

 Superscript: Text that appears smaller and higher than normal text.  
 Example: 10². 

 

439. Spooling 

 Temporarily stores data in memory for bulk processing by peripherals (e.g., printers).  
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440. Computer Virus  

 Term first defined by Fred Cohen in 1983. 
 A virus attaches to programs, triggering its action upon execution of the host program.  

 

441. Widely Adopted Number System 

 Decimal Number System: Most widely used (digits 0-9). 
 Other Systems: 

o Binary: Base 2 (digits 0,1). 
o Octal: Base 8 (digits 0-7). 
o Hexadecimal: Base 16 (digits 0-9, A-F). 

 

442. Abacus  

 Abacus : Early calculating tool using beads to represent data. 
 Origin: Used in Europe, China, and Russia before written numeral systems. 

 Modern Use: Teaching arithmetic.  

 

443. Virtual Memory 

 Virtual Memory: Allows RAM to appear larger by utilizing secondary storage.  
 Data flows between RAM and storage based on demand.  

 

444. Macro 

 Macro: A sequence of instructions automating repetitive keyboard and mouse actions.  
 Used in MS Word and Excel for efficiency and error reduction.  

 

445. Emulator 

 Emulator: Hardware or software that enables one system to imitate another.  
 Example: Running guest system applications on a host. 

 

446. Google Camera 

 Supported officially only on Google Pixel devices. 
 Initially supported devices with Android 4.4 KitKat and higher. 
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447. Apple LISA 

 LISA: First commercial computer with a Graphical User Interface (GUI). 
 Developed by Apple. 
 Acronym: Locally Integrated Software Architecture . 

 

448. Application Software 

 Designed for specific needs of a particular environment.  
 Examples: 

o Microsoft Office Suite (Word, Excel, PowerPoint). 

o Payroll Software, Inventory Management, Railways Reservation. 

 

449. Shareware 

 Proprietary software initially provided free of charge for evaluation. 
 Users are encouraged to share copies.  

 

450. Database Management System Hardware Requirements 

 High-speed processor and large storage are essential for efficient DBMS operation.  

 

451. URL (Uniform Resource Locator) 

 Reference to a web resource specifying location and retrieval mechanism. 
 Used for web pages (http), file transfer (ftp), email (mailto), etc. 

 

452. Firefox OS 

 Firefox OS: Mobile operating system by Mozilla. 

 Discontinued, initially released in 2013 for smartphones and smart TVs. 

 

453. Network Interface Card (NIC) 

 A hardware component enabling computers to connect to a network.  
 Allows wired or wireless communication. 

 Also known as network adapter or LAN adapter. 
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454. Recycle Bin 

 A special folder where deleted files are temporarily moved until permanently deleted.  

 

455. KIPS Architecture 

 KIPS: Knowledge-based Information Processing System. 
 Used in fifth-generation computers focusing on artificial intelligence and natural language input.  

 

456. Operating System Types 

 Types of Operating Systems: 
o Batch OS. 
o Time-Sharing OS. 

o Network OS. 
o Distributed OS. 

o Real-Time OS. 

 

457. Font Size Shortcut in MS Word 

 Ctrl + [: Decreases font size by 1 point. 
 Ctrl + ]: Increases font size by 1 point. 

 

458. Mini Toolbar 

 Mini Toolbar: Appears when text is selected in Office applications like Word, Excel, or PowerPoint.  
 Functions: Formatting text (font type, size, color, alignment). 

 

459. Word Processing Tools 

 Word processing refers to creating, editing, and printing documents using word processors.  
 Examples: MS Word, Google Docs, LibreOffice Writer. 

 

460. Brave Browser 

 Brave: A free, open-source, privacy-focused web browser developed by Brave Software, Inc.  
 Features: Blocks ads and website trackers by default.  
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461. Largest WAN 

 Internet: The largest Wide Area Network (WAN), spanning the globe. 

 

462. Optical Character Recognition (OCR) 

 Recognizes text in digital images and converts it into editable formats.  
 Used for converting printed, handwritten, or typed text into machine-encoded text. 

 

463. Star Topology 

 Hub acts as a repeater for data flow. 
 All nodes are connected to a central hub via cables.  

 

464. Father of Modern Computer Science 

 Alan Turing: Known as the Father of Modern Computer Science . 
 Other Notables: 

o Charles Babbage: Father of Computing. 

o Edgar Frank Codd: Invented relational database model.  

 

465. HTML 

 HTML: Hyper Text Markup Language. 
 Standard language for creating web pages displayed on the Internet.  

 

466. Column Width in MS Excel 

 Column width: 255 characters. 
 Row height: 409 points. 

 Maximum rows: 1,048,576. 
 Maximum columns: 16,384. 

 

467. PROLOG 

 PROLOG: Programming language used for artificial intelligence applications, especially expert systems. 

 



 

76 

 

468. Trojan Horse Virus 

 Enters systems via emails or free downloads. 
 Damages devices by installing harmful software.  

 

469. Sending an Email 

 Similar to exchanging digital messages between computer networks. 

 

470. First Web Browser 

 WorldWideWeb: The first web browser (1990), later renamed Nexus. 

 

471. Logic Gates 

 Logic Gates: Basic building blocks of digital circuits.  
 Examples: AND, OR, NOT, NOR. 

 

472. Installation 

 Installation: The process of preparing software for execution on a computer.  
 May include copying files, modifying registry entries, or setting up dependencies.  

 

473. Software Bug 

 A software bug is an error in a program causing unintended behavior.  
 Effects: Crashes, freezes, or security vulnerabilities.  

 

474. SMTP 

 Simple Mail Transfer Protocol (SMTP): Internet standard for sending email messages.  

 

475. USB 

 Universal Serial Bus (USB): A plug-and-play interface allowing communication with peripheral devices.  
 Examples: Keyboards, mice, flash drives. 
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476. Nibble 

 Nibble : A group of 4 bits. 
 Byte: A group of 8 bits. 

 

477. Fourth-Generation Computers 

 Period: 1971-1980. 
 Features: 

o Used Very Large Scale Integrated (VLSI) circuits. 
o Examples: IBM 4341, DEC 10, Apple Series I & II. 

 

478. Parental Control Software 

 Protects children online by: 
o Monitoring activity. 

o Blocking harmful websites. 
o Filtering inappropriate content.  
o Limiting screen time. 

 

479. Mydoom Virus  

 Mydoom: One of the worst computer viruses in history, causing $38 billion damage in 2004. 
 Technically a worm, spread through mass emailing. 

 At its peak, it was responsible for 25% of all emails sent. 

 

480. Name Box in MS Excel 

 Displays the current cell address. 
 Located to the left of the formula bar. 

 

481. Limitations of Parental Control 

 Creates a false sense of security. 
 Limits children's ability to explore the internet for learning.  

 Can cause trust issues between parents and children. 
 Tech-savvy children may bypass controls. 
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482. Applications of Operating Systems 

 Manages hardware, software, and user interactions.  
 Examples: 

o Windows, Linux, Macintosh, Android, iOS, Ubuntu, Fedora. 

 

483. SSD (Solid-State Drive) 

 Storage device with no moving parts. 

 Uses flash memory for high-speed data access. 
 Key components: Flash controller and NAND flash memory chips . 

 

484. Lines in MS Word 

 Red Line: Spelling errors. 
 Green Line: Grammatical errors. 
 Blue Line : Contextual errors (e.g., correct spelling but wrong usage).  

 

485. CC in Email 

 CC: Carbon Copy. 
 BCC: Blind Carbon Copy (recipients remain hidden). 

 

486. Time-Sharing OS 

 Allows multiple users at various terminals  to use a computer simultaneously. 
 Example: Unix. 

 

487. Toggle Keys 

 Examples: Caps Lock, Num Lock, Scroll Lock. 
 Functions: 

o Caps Lock: Capitalizes all letters. 
o Num Lock: Enables numeric input. 

o Scroll Lock: Allows arrow keys to scroll through content.  

 

488. First Web-Based Email Service 

 Hotmail: Launched on 4th July 1996. 
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489. Apple's Spreadsheet Application 

 Numbers : Part of Apple's iWork productivity suite . 
 Allows import/export of Excel and CSV files  and supports advanced functionalities.  

 

490. Dial-Up Communication Protocols  

 PPP (Point-to-Point Protocol): Enables dial-up connections to other network protocols like TCP/IP.  
 Features: Password protection, error correction. 

 

491. Flash Memory 

 A type of EEPROM (Electronically Erasable Programmable Read-Only Memory). 
 Examples: 

o BIOS chip, USB drives, CompactFlash. 

 

492. IPv4 Address Scheme 

 IPv4: 32-bit address scheme. 
 Written in decimal and separated by periods. 

 

493. Toggle Case 

 Converts text into mixed case (e.g., "dIctIOnAry"). 
 Used to shift between different case views.  

 

494. Number Systems 

 Common Types: 
o Decimal, Binary, Octal, Hexadecimal. 

 Not a Number System: Anything unrelated to these types.  

 

495. Debugging 

 Process of detecting and fixing errors (bugs) in software. 
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496. Non-Programming Language 

 Examples of programming languages: Python, C, C++, Java. 
 Microsoft Bing: A web search engine, not a programming language.  

 

497. Node in Data Communication 

 A node is any device that sends, receives, or stores data in a network.  
 Examples: Modem, hub, router, switch, server, digital telephone . 

 

498. Spooling 

 Temporary holding of data for execution by a device, program, or system. 
 Example: Print spooling. 

 

499. Guided Media 

 Also known as Wired Transmission Media. 
 Signals are confined in physical links like: 

o Twisted Pair Cable. 
o Coaxial Cable. 

o Optical Fibre Cable. 

 

500. Horizontal Market Software 

 Software applicable across industries.  
 Examples: 

o Word processing, spreadsheets, operating systems. 
 Vertical Market Software: Designed for specific industries (e.g., banking, real estate).  

 

501. Chromecast 

 Chromecast: A dongle connecting to the TV's HDMI port to add smart functions. 
 Allows streaming content from a smartphone to the TV via the home network.  

 

502. Surface Web 

 Surface Web: Portion of the web accessible to the public and indexed by search engines.  
 Opposite of the Deep Web (unindexed). 
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503. Open-Source Software 

 Examples: 
o LibreOffice 
o GNU Image Manipulation Program. 

 Source code can be inspected, modified, and enhanced by anyone. 

 

504. Video Conferencing Applications 

 Examples: 
o Skype 

o Google Hangouts 
o WebEx 

o BlueJeans. 

 

505. Blu-Ray Disc 

 Blu-Ray: An example of Optical Memory. 
 Features: 

o High-capacity storage. 
o Designed for high-definition video and advanced audio formats.  

 

506. Tree Topology 

 Tree Topology: 
o Combines star and bus topologies. 
o Valued for scalability and troubleshooting accessibility. 

 

507. Invention of the Web 

 Tim Berners-Lee: Invented the Web in 1989 at CERN. 
 Publishing Language: HTML. 

 

508. Levels of Artificial Intelligence 

 Narrow AI: Performs specific tasks better than humans (current state of AI).  
 General AI: Performs intellectual tasks at the same level as humans.  
 Strong AI: Surpasses human capabilities in many tasks.  
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509. Tactile Haptic Feedback 

 Used in mobile devices for touch sensations.  
 Responds to pressure or vibrations during interaction. 

 

510. Non-Antivirus Software 

 CyberLink PowerDirector: A video editing software, not an antivirus. 
 Examples of Antivirus: 

o Norton 
o Kaspersky 
o Bitdefender. 

 

511. Giphy 

 Giphy: A public database of animated GIFs. 
 Acquired by Facebook in May 2020 for $400 million. 

 

512. File Extensions  

 .com: Simple executable file. 
 Common extensions: 

o .exe: Executable files. 

o .bat: Batch files. 
o .txt: Text files. 

 

513. Apple Keynote 

 Keynote: Presentation software by Apple.  
 Features: 

o Create slideshows with images, videos, text, and animations . 

 

514. Non-Application Server 

 IIS (Internet Information Services): A Web Server, not an application server. 
 Examples of Application Servers: 

o JBoss 

o WebLogic 
o WebSphere. 
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515. PHP 

 PHP: Hypertext Preprocessor. 
 A server-side scripting language for creating dynamic websites and web applications. 

 

516. IPng 

 IPng (Internet Protocol: The Next Generation): 
o Officially named IPv6. 

o Replaces IPv4 due to the insufficiency of address space.  

 

517. Arrow Keys 

 Cursor control keys: Up, Down, Left, Right. 
 Functions: 

o Move the cursor within a document or interface.  
o Home: Moves cursor to the beginning of a line. 

o End: Moves cursor to the end of a line. 
o PgUp: Moves cursor up one page. 
o PgDn: Moves cursor down one page. 

 

518. Judy Malware 

 Judy: An ad-clicking malware affecting multiple operating systems.  
 Infected nearly 41 Android apps, generating fraudulent clicks on advertisements.  

 

519. Starting Element in HTML Document 

 HTML Document starts with: 
o A "start tag" (e.g., <p>) and an "end tag" (e.g., </p>). 
o Nested tags may include attributes like identifiers or style information.  

 

520. Text Alignment in Word Processing 

 Left Justify: Aligns text to the left margin. 
 Right Justify: Aligns text to the right margin. 
 Center: Centers lines of text. 

 Fully Justified: Aligns text to both margins by adjusting spacing.  
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521. Punch Card System 

 Invented by Herman Hollerith, an American Statistician. 
 Used for data storage and retrieval via punched holes. 

 

522. Bookmarklet 

 A bookmark containing JavaScript commands . 
 Adds new features to a browser, such as running search queries or extracting data.  

 

523. MS Excel Function Keys 

 F9: Calculates all worksheets in all open workbooks.  
 F1: Opens the Help pane. 
 F7: Opens the Spelling dialog box. 

 

524. Cloud Computing 

 Ensures effective online backup of data. 
 Provides shared processing resources and data storage over the Internet.  

 

525. URL (Uniform Resource Locator) 

 URL: The address of a resource on the web.  
 Can refer to HTML pages, images, CSS documents, etc.  

 

526. MS Word Functions  

 Examples: 
o Background Removal Tool: Makes parts of an image transparent. 
o Integrated Translator: Translates text or entire documents.  
o Screenshot Tool: Inserts screenshots into documents.  

 

527. Petabyte  

 1 Petabyte ≈ 1024 Terabytes or 10¹⁵ bytes. 
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528. Non-Hacking Technique 

 Examples of hacking techniques: 
o Botnets, Ransomware, Trojans, Viruses, Worms. 

 Malvertising and social engineering are also common. 

 

529. RAID 

 RAID: Redundant Array of Independent Disks.  

 Uses multiple disks for fault tolerance, performance improvement, and increased storage capacity. 

 

530. Mesh Topology 

 Each node carries traffic only between two connected nodes . 
 Techniques: 

o Routing: Uses shortest paths. 
o Flooding: Broadcasts data to all nodes. 

 

531. File Extension 

 Indicates file type (e.g., .txt for text files, .exe for executables). 
 Example: myfile.txt has a .txt extension. 

 

532. Word Processor 

 Performs tasks like composing, editing, formatting, storing, and printing documents . 
 Early examples combined text-entry and recording units. 

 

533. FTP (File Transfer Protocol) 

 Standard protocol for transferring files between a client and server on a network. 

 

534. MS Word Shortcuts 

 Ctrl+Alt+S: Splits the document window. 
 Alt+Shift+C: Removes the split. 
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535. BIOS 

 BIOS (Basic Input/Output System): 
o Built- in software for basic hardware functions like keyboard and display control. 

 

536. First Commercial Microprocessor 

 Intel 4004: Introduced in 1971 by Intel. 
 Developed by Federico Faggin, Marcian E. Hoff, and Stan Mazor. 

 

537. Spoofing 

 Spoofing: Fraudulent practice where communication is sent from an unknown source disguised as a known 
source. 

 Common in: 

o Emails requesting personal information. 
o Used for identity theft. 

 

538. Fourth-Generation Computers (1971–1980) 

 Used VLSI circuits for processing. 
 Features: 

o Semiconductor memory for primary storage. 

o Magnetic disks for secondary storage. 
o Supported multiprocessing and multitasking. 

 Examples: 

o IBM 4341 
o DEC 10 

o Apple I & II 

 

539. Pratyush Supercomputer 

 Purpose: 
o Weather forecasting and climate monitoring. 

o Used for monsoon prediction, air quality, and extreme events like cyclones. 
 Established at: 

o IITM Pune. 
o NCMRWF Noida. 
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540. Full Duplex Data Transmission 

 Full Duplex: Data flows in both directions simultaneously. 
 Example: Telephone networks. 

 Other modes: 
o Simplex: One-way (e.g., Keyboard to Monitor).  

o Half Duplex: Two-way but one direction at a time (e.g., Walkie-talkie). 

 

541. TCP/IP Layers  

 Application Layer: Contains high- level protocols (e.g., TELNET, FTP, SMTP, DNS, HTTP). 
 Other layers: 

o Host-to-Network: Connects host to network. 
o Internet: Handles IP packets. 

o Transport: Uses TCP and UDP for end-to-end communication. 

 

542. Relational Database Management Systems 

 Represents data as tables (relations). 
 Examples: 

o DB2, Informix (IBM). 
o Oracle, RDB (Oracle). 

o SQL Server, Access (Microsoft). 

 

543. Biometrics 

 Identifies individuals using unique physical or behavioral characteristics . 
 Examples: 

o Fingerprints 
o Facial patterns  
o Voice recognition 

 

544. Apache OpenOffice Components 

 Includes: 
o Writer (Word Processor). 

o Calc (Spreadsheet). 
o Impress (Presentation). 
o Base (Database). 

o Math (Formula Editor). 
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545. Touchpad 

 Works by sensing finger movements and downward pressure. 
 Commonly used in laptops as an alternative to a mouse. 

 

546. Computer Resolution 

 Number of pixels on a display, expressed as: 
o Horizontal × Vertical pixels. 

 Higher resolution = Sharper image. 

 

547. Bandwidth 

 Measured in bits per second (bps), kilobits, or megabits. 
 Represents the maximum data transfer rate of a communication link. 

 

548. Registers in CPU 

 Program Counter: Holds the address of the instruction to be executed. 
 Other registers: 

o Data Register: Temporarily stores data. 

o Instruction Register: Stores the instruction code. 

 

549. Output Devices 

 Examples: 
o Monitor 
o Printers 
o Braille Reader 

 Not an output device: Microphone (input device). 

 

550. MS Excel Function Keys 

 F2: Edit the selected cell.  
 F5: Go to a specific cell. 
 F7: Check spellings. 
 F11: Create a chart. 

 



 

89 

 

551. Booting 

 Cold Boot: Turning on the computer from an off position.  
 Warm Boot: Restarting without turning off the power.  

 

552. Auxiliary Port 

 Used for: 
o MP3 players, Headphones, Speakers. 

 Not used for: Microphone. 

 

553. SQL (Structured Query Language) 

 A standardized language for database management. 
 Functions: 

o Store, retrieve, update, and manage data. 

 

554. Spooling 

 Temporarily holds data for execution. 
 Example: Print spooling to queue print jobs. 

 

555. Recycle Bin 

 Temporary storage for deleted files. 
 Functions: 

o Allows recovery of files before permanent deletion.  
o Files can be browsed or permanently deleted. 

 

556. Disk Operations and Performance 

 Disk Tracks : A disk is divided into circular tracks, further divided into blocks called sectors. 
 Seek Time : Time for the read/write head to move between tracks. Lower seek time = Better 

performance. 

 Rotational Latency: Time required for the disk to rotate to the requested sector.  
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557. Dynamic Host Configuration Protocol (DHCP) 

 RFC 2131: DHCP dynamically assigns IP addresses to devices on a network, automating network 
configurations. 

 Eliminates the need for manual IP assignment. 

 

558. Big Iron (Mainframe Computers) 

 Big Iron: Refers to mainframe computers, known for high performance, reliability, and security.  

 Examples: IBM z Series, System z9, System z10 servers.  
 Used for bulk data processing like census and transaction processing.  

 

559. Shortcut for Redo Action 

 CTRL + Y: Redoes the most recent action. 
 Press repeatedly to redo multiple actions.  

 

560. GNU 

 GNU is an example of an assembler, converting assembly code into binary machine code recognizable by 
processors. 

 

561. Name Server 

 A fundamental part of DNS, connecting URLs to IP addresses. 
 Works like a contact list, linking domain names to IPs. 

 

562. Third Generation Computers 

 Key innovation: Integrated Circuits (ICs). 
 Improved speed and efficiency. 
 Generations: 

o 1st: Vacuum Tubes. 
o 2nd: Transistors. 

o 4th: VLSI. 
o 5th: ULSI and quantum computing. 
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563. Ransomware 

 A form of malware that encrypts data and demands a ransom for decryption. 
 Often paired with deadlines for payments.  

 

564. Fifth Generation Computers  

 Based on ULSI microprocessors (Ultra Large Scale Integration).  
 Period: 1980–onwards. 

 

565. Open-Source Operating Systems 

 Example: Linux. 
 Modifiable and distributable  by anyone. 

 

566. CDMA 

 Stands for Code Division Multiple Access. 
 A channel access method using spread spectrum technology for multiple users. 

 

567. Integrated Development Environments (IDE) 

 Combines text editing, building, and debugging tools.  
 Examples: NetBeans, Eclipse, Python IDLE, Atom. 

 

568. Firmware 

 Stored in non-volatile memory like ROM, EPROM, or flash memory. 
 Found in devices like BIOS chips, smartphones, digital cameras, and IoT devices . 

 

569. Invention of the Computer Mouse 

 Invented by Douglas Engelbart in 1964. 
 Initially made with a wooden shell and metal wheels. 
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570. Microsoft Edge 

 A web browser developed by Microsoft, formerly known as Internet Explorer. 

 

571. Candidate Key 

 A minimal superkey without redundant attributes, uniquely identifying rows in a table.  

 

572. First Commercial Computer 

 UNIVAC: Delivered to the U.S. Census Bureau in 1951. 
 Designed for business applications. 

 

573. MS Word Shortcuts 

 Alt + G: Opens the Design Tab. 
 Other shortcuts: 

o Alt + H: Home Tab. 

o Alt + N : Insert Tab. 

 

574. Repeaters 

 Operate at the physical layer. 
 Do not amplify signals; instead, regenerate them at original strength.  

 

575. Hard Copy 

 Refers to a physical printout on paper, e.g., computer printouts or teleprinter pages.  

 

576. Layers in the Internet Model 

 Link Layer: Lowest layer, handles sending and receiving actual data.  
 Application Layer: Uppermost layer, defines protocols for user interaction (e.g., FTP, HTTP). 

 

577. Batch Processing 

 Definition: Processes multiple requests together, reducing user wait times.  
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 Example: Mail delivery systems processing all orders at once.  

 

578. LAN Data Rates 

 LAN offers high-speed communication with data rates up to 1000 Mbps. 
 Uses twisted pair and coaxial cables.  

 

579. External Level in Database Architecture  

 External Level: The highest level of data abstraction, viewed as rows and columns.  
 Known as the View Level: Users see full/partial data based on access rights.  

 

580. IPv4 Addressing 

 IPv4: 32-bit address written in decimal and separated by periods . 
 First deployed in ARPANET (1983) for identifying network devices.  

 

581. Monitor Types 

 LCD : Uses compact fluorescent tubes for illumination. 
 CRT: Creates images using electron beams.  

 LED : Utilizes improved backlighting for better picture quality.  
 OLED : Made of organic materials, converting electric current to light.  

 

582. Maximize Button 

 Enlarges a window to cover the entire desktop.  
 Changes to a Restore button when maximized. 

 

583. Hybrid Topology 

 Definition: Combines two or more topologies (e.g., ring and star).  
 Advantages: Reliable, scalable, flexible. 
 Disadvantages: Complex design, costly. 

 

584. Adding Charts in MS PowerPoint 

 Insert > Chart: Choose chart type and enter data to create a chart.  
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585. Toolbar in Web Browsers  

 Contains navigational buttons like Home, Print, and Search. 
 Functions : 

o Home: Opens starting page. 

o Print: Prints the current page. 
o Reload: Refreshes the page. 

 

586. Java Programming 

 Purpose: For applet creation, cross-platform development. 
 Used in embedded devices, mobile phones, and enterprise servers.  

 

587. Server Software  

 Back-End Applications: Support client computers by managing resources and services.  

 

588. Spooling 

 Overlaps low-speed operations with normal processing.  
 Common in printer operations. 

 

589. Trojan Horse 

 Malicious program disguised as legitimate software. 
 Can steal personal information, spread across networks, and deliver ransomware.  

 

590. Encoder 

 Converts digital signals into a transmittable format. 

 Common in motion control systems. 

 

591. IP Header 

 Contains information such as: 
o Source/Destination IP Address 

o Packet Length 
o Time to Live (TTL). 
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 Does not include payload data. 

 

592. Folder 

 A named area on a disk used to store related files and subfolders.  

 

593. Excel Editing Key 

 F2: Activates Edit mode to modify cell content.  

 

594. Infrared Transmission Devices 

 Used in TV remote controls, short-range communication. 

 

595. Computer-Aided Design (CAD) 

 Used for designing and analyzing structures like bridges and buildings. 
 Improves productivity and communication in design documentation.  

 

596. Quora - Question-and-Answer Website 

 Quora: A question-and-answer website launched on June 21, 2010. 
 Allows users to ask, answer, edit, and organize questions . 
 Users can collaborate by editing questions and commenting on answers . 

 

597. Lowest Layer in OSI Model 

 Physical Layer: The lowest layer in the OSI model. 
 Functions : 

o Handles the physical connection between devices.  

o Transmits data in the form of bits. 
o Converts signals into 0s and 1s for data transfer to the Data Link Layer. 

 

598. Features of WhatsApp 

 End-to-End Encryption: Secures chat backups. 
 WhatsApp Payments : Facilitates money transfers.  
 Desktop Compatibility: Can be used on a desktop computer.  
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 Launch Platform: Initially launched on iOS. 

 Contact Syncing: Allows managing synchronization for multiple accounts. 

 

599. Internet Protocol (IP) 

 IP: The main protocol for relaying data across networks.  
 Part of the Internet Protocol Suite , which includes: 

o TCP/IP: Transmission Control Protocol.  
o UDP/IP: User Datagram Protocol. 

o HTTP: Hypertext Transfer Protocol. 
o FTP: File Transfer Protocol. 

 

600. Chart Option in MS Excel 

 Found under the Insert Tab in the Illustrations Group. 
 Steps to Insert Chart: 

1. Go to Insert Tab. 
2. Select Chart from the Illustrations group. 

3. Choose the desired chart type from the Insert Chart Dialog Box. 
4. Click OK to create the chart. 

 


